
NATIONAL GUARD BUREAU 
3501 FETCHET AVENUE 

JOINT BASE ANDREWS MD 20762-5157 

 

          18 Aug 2021 

MEMORANDUM FOR SEE DISTRIBUTION 

 

FROM:  NGB/A4 

 

SUBJECT:  Air National Guard Engineering Technical Letter (ANGETL) 21-14, Air National 

Guard Capitalization and Construction in Progress (CIP) Process 

 

1.  PURPOSE:  This ANGETL documents a Financial Improvement and Audit Readiness 

(FIAR) compliant process to be used to track ANG CIP and capital improvements (CIMP) to 

existing assets.  It outlines the ANG process to account for the costs associated with all ANG 

construction type projects (major & minor construction) and work items whose full, or partial, 

value is determined to be capitalized and/or expensed by the base Real Property Officer/Base 

Civil Engineer.   

 

2.  APPLICABILITY:   

2.1.  Effective Date: Immediately. 

 

2.2.  Ultimate Recipients: NGB/A4A Programmers and Real Property, NGB/A4O Project 

Managers, Base Civil Engineers (BCEs) and Deputy BCEs, Real Property Managers (RPMs), 

and United States Property Fiscal Officers (USPFOs) which are the Real Property Accountable 

Officers (RPAOs). 

 

2.3.  Coordination with Key Organizations: NGB/A4A, NGB/A4O, and select field 

representatives. 

 

3.  DESCRIPTION AND IMPLEMENTATION: 

  

 3.1. This ANG ETL provides guidance and clarification on ANG Construction in Process 

encompasses the execution of real property projects from the establishment of the Project/Work 

Item Approval document to project closeout. 
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4. POINT OF CONTACT:  The point of contact for this ANGETL is Julie Hanania,

NGB/A4AI, at (240) 612-7927, DSN 612-7927, or email julie.hanania.1@us.af.mil.

KEVIN L. MATTOCH, P.E. 

Associate Director, Engineers

Attachment: 

1. ANG Capitalization and CIP Process

2. ANG ETL Index

Distribution: 

Each BCE, DBCE and RPM 

NGB/A4A 

NGB/A4O 

mailto:julie.hanania.1@us.af.mil
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Air National Guard Capitalization  


and  


Construction in Progress (CIP) Process 


 


 


1. PURPOSE.  This ANGETL documents a Financial Improvement and Audit Readiness 


(FIAR) compliant process to be used to track ANG CIP and capital improvements (CIMP) to 


existing assets.  It outlines the ANG process to account for the costs associated with all ANG 


construction type projects (major & minor construction) and work items whose full, or partial, 


value is determined to be capitalized and/or expensed by the base Real Property Officer/Base 


Civil Engineer.  Costs to be capitalized will be limited to those identified in the corresponding 


Project/Work Item Approval Document to include, construction, supervision, inspection, and 


overhead (SIOH) and equipment (RPIE or EIP) costs.  Key supporting documents are required to 


ensure auditability. The construction manager will maintain copies of key supporting documents 


in the project folder.  Key supporting documents that must be maintained in the project folder 


include: all versions of the DD Form 1391 (drafts, revisions, and final copy), all versions of the 


DD Form 1354; all design instructions, all field design instructions, are identified in AFI 32-


1023, 23 DECEMBER 2020 and this ANGETL. 


 


2.  DESCRIPTION.  The ANG Construction in Process encompasses the execution of real 


property projects from the establishment of the Project/Work Item Approval document to project 


closeout.  CIP encompasses all costs for design, construction, supervision, inspection and 


overhead (SIOH) and real property installed equipment, as well as additional project costs 


necessary for construction such as land acquisition and demolition.  CIP costs are recorded in the 


CIP account (recorded in NexGen IT Projects) based on costs documented in an approved DoD 


financial system, substantiated by documentation including (but not limited to) invoices for 


contract payments, labor reports, and funding authorization documents.  All project costs 


recorded in the CIP account must be traceable to the “component unique project number” 


specified on the DD Form 1391 for the project and at least one real property unique identifier 


[RPUID] for a real property asset identified on the Draft DD Form 1354 for the project.  


Financial accounting for CIP and supporting documentation should identify the funding 


account(s) (e.g. 3830 for Air National Guard MILCON or 3840 for SRM) and funding 


organization (Air National Guard).  This process involves the coordination of multiple ANG 


offices and functions, including but not limited to NGB/A4A (Asset Management), NGB/A4O 


(Operations), the Base Civil Engineer (BCE), the United States Property and Fiscal Officer 


(USPFO)/Design or Construction Agent (Real Property Accountable Officer (RPAO)), and the 


Real Property Manager (RPM).   


 


3. REFERENCES. 


3.1  DAFI 32-9005, Real Property Accountability and Reporting 


3.2  NexGen IT Reference Guides  


3.2.1  Real Property 


3.2.2  Project Management 


3.2.3  Cost Accounting 


3.3  ANGI 32-1023, Criteria & Standards for Air National Guard Design and 


Construction 
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3.4  DoDI 7000.14-R Financial Management Regulation (FMR) 


3.4.1  Volume 3: Budget Execution Availability and Use of Budgetary Resources 


Policy 


3.4.2  Volume 4: Accounting Policy 


3.5  UFC 1-300-08, 16 April 2009, Change 2, August 2011, Criteria for Transfer and 


Acceptance of DoD Real Property 


 3.6  OUSD Memorandum: Real Property Financial Reporting Responsibilities Policy 


Update (FMP #19-05), dated 15 March 2019 and the FASAB Handbook 


3.7  ANGETL 15-03, MILCON Project Closeout Process  


3.8  AFI 32-1023, Designing and Constructing Military Construction Projects 


 


4. DEFINITIONS. 


 


4.1  Construction in Progress (CIP) - Construction in Progress is an accounting term 


that refers to a temporary classification of facility–type assets under construction (CONT).  The 


costs of new construction are accumulated in a Construction in Progress Account while the asset 


is under construction. Construction in Progress Accounts include all costs incurred to bring the 


asset to a form and condition suitable for its intended use. The sum of the individual costs in the 


Construction in Progress Account will determine the total cost of the asset that is then recorded 


in the appropriate general property, plant, and equipment ledger account.  Construction in 


progress for real property is reported by the funding entity in its Construction in Progress 


Account until the asset is placed-in-service.  When the asset is placed-in-service, the construction 


in progress will be relieved by the funding entity.  At this time, an asset will be recorded by the 


funding entity and interim/final DD Form 1354 will be used to document the new construction.  


(Note - Capital improvement (CIMP) type work costs are not tracked in the CIP account in 


NexGen IT.  Costs are tracked through the NexGen IT Real Property close out, but not in the CIP 


account. If a Capital Project has both CONT and CIMP type work, the CONT costs will track to 


a CIP account.) 


 


4.2    DD Form 1354 Transfer and Acceptance of DoD Real Property DoD form - 


used to identify all DoD Real Property transferred into or out of the Real Property inventory. All 


Acquisition by Construction will be received on a DD Form 1354 within NexGen IT. 


Acquisitions through RE processes will be submitted through a RE Transaction Plan and will not 


include a NexGen IT- generated DD Form 1354. Instead, a paper copy DD Form 1354 (when 


applicable) will be uploaded to the ‘Notes & Documents’ tabs. 


The DD Form 1354 types include: 


 Draft - A Draft DD Form 1354 does not have any GL impacts, and is required 


before project is awarded. 


 Interim - An Interim DD Form 1354 is created when the facility is complete, 


usable and it has been accepted for use. It reflects the point in time when the 


identified portion of the facility has been placed in service 


 Final - A Final DD Form 1354 is submitted when all construction on a project 


with Type C services or work task has been completed, paid, and accepted 


 


4.3  Design Agent/Construction Agent (DA/CA) - Is the agent used to provide Design 


services and/or Construction services for the project/work item. In most cases the USPFO is the 
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DA and CA for the ANG. Occasionally, or in specific locations, the ANG may uses the services 


of the Army Corps of Engineers or the Navy as the DA or CA. Also, can be NGB/A4AIR 


directed for Found On Base or Inventory adjustments. 


 


4.4  Electronic Documents Access (EDA) -Is an online document access system 


designed to provide acquisition related information for use by all of the Department of Defense. 


 


4.5  DD 1391 FY Military Construction Project Data - prepared in accordance with the 


MILCON or FSRM DD-1391 business rules, shall be established prior to the start of design and 


provided to the DoD construction agent. The component unique project number appearing on the 


DD-1391 cannot be changed once design starts unless approved by NGB/A4A. 


 


4.6 Asset Cost Record (ACR) - The ACR is the foundation for calculating asset values 


for the General Ledger (GL).  The ACR allows the DoD, and each military component, to 


maintain an accurate balance sheet and Financial Report.  Every asset, with its own RPUID, has 


an ACR Table associated with it. The ACR Table serves as a journal or check register of all the 


acquisition costs and capital improvement costs accumulated on the asset over time. In addition, 


the ACR calculates and tracks the depreciation of the asset over time. 


 


4.7 General Ledger (GL) - GL activities are critical for the system to account for the 


status, cost, and condition of RP assets, as well as the reporting for preparation of the AF 


Financial Statement. The Installation RPAO is responsible for entering accurate data into the 


Asset Records in NexGen IT for GL transactions. These GL transactions are sent to DEAMS and 


will support a key portion of RP FIAR compliance.  In addition to the Acquisition, Maintenance, 


and Disposal phases of the RE Lifecycle, there are processes that occur throughout the lifecycle 


that affect the GL. 


 


4.8 CIP Phase Indicator - The ‘CIP Phase Indicator’ is a read-only field that can be 


found in the ‘Facility’ section of the ‘Real Property Inventory Management (RPIM)’ tab of the 


‘Real Estate (RE) Asset Record’. The ‘CIP Phase Indicator’ denotes whether an asset is 


constructed in multiple phases. Phased construction will include multiple acquisition records 


against the ACR. The ‘CIP Phase Indicator’ will default to “null” on the ‘Asset’ form. The ‘CIP 


Phase Indicator’ will change to “Y” when an additional RE Project Acquisition is completed for 


a phase of construction. 


 


5.  PROCESS STEPS:  Types of Acquisitions and Accountability Procedures. 


 


STEP 1:  Appropriate Authority (see Table 6-1) determines whether a project/work item 


is considered for capitalization and whether the full value of the project/work item or only a 


percentage of the value of the project/work item is to be capitalized, expensed or CIP captured. 


(ref. AFI 32-9005) 


 


Capitalization determination: The following business rules will determine if a project/work 


item will be considered capitalization/expense or CIP will be tracked: 


a) Seven types of Acquisition or Capital Improvement Records on the ACR:  
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o A Record: Most common record for standard acquisitions above 


the capitalization threshold. An A Record should be created for the 


Acquisition of an asset via an Acquisition Project that has been 


completed  


o V Record: Less common acquisition record for non-land assets for 


which the value of the asset must be estimated because there is no 


documentation showing the original acquisition costs. This is most 


commonly used for donations and gifts or for inventory 


adjustments (i.e., found on base)  


o L Record: Acquisition record for land assets  


o  I Record: Most common record for capital improvements to assets 


above the capitalization threshold  


o IEL Record: Unique record for capital improvements that extends 


the useful life of the asset, regardless of the capitalization threshold  


o E Record: An expensed improvement to the asset that is below the 


applicable capitalization threshold as it pertains to the ‘Placed in 


Service Date’  


o ADJ Record: Record used to document changes to both acquisition 


and capital improvement records. Adjustments occur when data, 


such as placed in service dates or costs, is changed that impacts the 


value of the asset. ADJ-records will also be written for Final DD 


Form 1354s when an Interim DD Form 1354 was processed on the 


same capital project or work task.  


b) New construction (Construction (CONT) type Capital Projects) 


c) Purchased land with or without facilities 


d) Leases 


e) Revision of a previous acquisition contract 


f) Transfer from another DoD Service 


g) Transfer from one federal entity to another 


h) A gift or donation 


i) Demolitions (DEMO type Capital Projects) 


j) Found on Base 


k) Inventory Adjustments 


NOTE: This procedure is different than inventory adjustments that change occupancy or square 


footage found during the Asset Review process.  


 DSP Record: The Disposal Record is written by the system upon completion of a RE 


Project Disposition for both full and partial disposals. The system will also generate an 


ADJ record to help account for depreciation on the remaining value of the asset  


 For disposal records, the user should select the ‘Add Asset Capital Improvement Detail’ 


record option to create the ADJ record.  


 The current capitalization threshold is $250,000. NexGen IT is currently configured to 


enforce this threshold and records below the thresholds must be expensed i.e., E-Record. 


 


STEP 2:  An Opportunity will initiate the Capitol Project in NexGen IT.  NGB/A4A 


requests a facility number (from NGB Real Property or base real property) to establish a facility 
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candidate record in the IT System (NexGen IT).  Before a NexGen IT Capital Project is 


authorized for Design, where a DI is issued, a facility number will be included on the DD Form 


1391. 


 


STEP 3:  Capital Projects is approved at the authorized level. The Project/Work Item 


Approval is a Key Supporting Document (KSD) to be kept in the official Facility Folder.  The 


CIP Reporting Process begins with project and ends with upon receipt of the Final DD Form 


1354. It is at this point a CIP Account is created for a Capitol Project with CONT type work and 


auto tracked based on DEAMS transactions or tracked based on manual inputs using the Design 


Estimate and SIOH data fields on the Capital Project (ref. UFC 1-300-08). 


 


 


TABLE 6-1: PROJECT/WORK ITEM APPROVAL 


Project Type 
Project/Work Item 


Approval 


Project/Work Item 


Approval 
Real Property ACR Type 


Local SRM, local funding (<=$400K 
529 or <=$1M 521,522,524) 


Approved by WRRB and 


recorded in iEMS 


iEMS Approval 


Record  


Real Property Office drafts a close out 


DD1354 to capture as I, IEL or E in 


NexGen RP 


Local SRM, NGB funding <=$100K 


(522 or 524) 


Approved by WRRB and 


recorded in iEMS 


iEMS Approval 


Record  


Real Property Office drafts a close out 


DD1354 to capture as I, IEL or E in 


NexGen RP 


Local SRM, NGB funding >$100K 


and up to $1M (521,522,524) 
BCE approved DD Form 


1391 


BCE Signed DD Form 


1391 


Real Property Office drafts a close out 


DD1354 to capture as I, IEL or E in 


NexGen RP 


NGB Approved SRM Repair $1-$5M 


(522 or 524) 


NGB/A4A Approved 


DD1391 


NGB/A4A Signed DD 


Form 1391 


Real Property Office drafts a close out 


DD1354 to capture as A, I, IEL or E in 


NexGen RP 


NGB Approved SRM Repair Between 


$5M and $7.5M (522 or 524) 
NGB/A4 Approved DD1391  


NGB/A4 Signed DD 


Form 1391 


Real Property Office drafts a close out 


DD1354 to capture as A, I, or IEL in 


NexGen RP 


NGB SRM Repair above $7.5M (522 


or 524) 


SAF approved and 


Congressional notification 


completed 


SAF Approval Memo 


Real Property Office drafts a close out 


DD1354 capture as A or I in NexGen 


RP 


NGB approved minor construction up 


to $1M (529) 


NGB/A4A Approved 


DD1391  
NGB/A4A Approved 


DD1391  
DD1354 to capture as A, I, or IEL 


which starts in NexGen IT Project 


NGB approved minor construction - 


$1M-$2M (529) 
NGB/A4 Approved DD1391  


NGB/A4 Approved 


DD1391  


DD1354 to capture as A, I, or IEL 


which starts in NexGen IT Project 


Unspecified Minor Military 


Construction between $2M and 


$6M (341) 


SAF approval and 


Congressional Notification 


completed 


SAF Approval Memo 
DD1354 to capture as A, I, or IEL 


which starts in NexGen IT Project 


Major MILCON project (321) 


National Defense 


Authorization Act becomes 


law 


National Defense 


Authorization Act 


DD1354 to capture as A or I which 


starts in NexGen IT Project 


 


STEP 4: NGB/A4A Approves/Releases project to NGB/A4O for Design (ref. ANGI 32-


1023). This is only required for NGB approval level projects. 


 


STEP 5: NGB/A4O issues Design Instruction and Design Funding (ref. AFI 32-1023 and 


ANGI 32-1023). This is only required for NGB approval level projects. 
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STEP 6: Design Agent (DA)/CA awards AE design contract. DA/CA/BCE schedules 


project design reviews (ref. ANGI 32-1023). 


 


STEP 7: DA/CA/BCE reviews design submittals, presents and obtains approval from 


NGB/A4O (ref. ANGI 32-1023).  NGB/A4AIR assists installation RPM in acquiring RPUIDs 


and any additional supporting facility numbers.  RPUIDs required will be solicited when 


construction starts.  NGB/A4O design review approvals are only required for NGB approval 


level projects.  


 


STEP 8: NGB/A4O Authorizes the Project to be solicited for construction and provides 


construction funding (ref. ANGI 32-1023).  This is only required for NGB approval level 


projects. BCE authorizes solicitation for construction of local level projects. 


 


STEP 9: Design Agent, Construction Agent, (CA), Programmer, or Project Manager, can 


draft a DD1354 in the Capitol Project.  However, the Real Property Manager should develop a 


Draft DD Form 1354 to assist the Programmer or Project Manager with capturing facilities 


starting at the Opportunity (a KSD and hard copy DD Form 1354 will have to be manually input 


to NexGen IT Real Property when project closes out).  This must be accomplished prior to the 


award of a construction contract and load the hard copy DD1354 into the notes and documents 


tab in the Capitol Project.  


 


STEP 10: Construction Agent (CA/BCE) solicits the project for construction pricing and 


provides results to NGB/A4O (ref. ANGI 32-1023).  Submission of results to NGB/A4O is 


required when seeking additional funds from NGB.   


 


STEP 11: NGB/A4O provides authority to award to CA for all MILCON with funding 


adjustment as necessary (ref. ANGI 32-1023). FSRM authority to award is not required however, 


funding in hand is required.   


 


STEP 12: Construction Agent (CA) awards construction contract (ref. ANGI 32-1023).  


 


STEP 13: CIP Reporting continues with construction payments (ref. Vol 4, Chapter 6 of 


the Financial Management Regulation (FMR).  The Non-Supply Funding Document process in 


NGIT will track these monthly CIP transactions.  There is a process to link the true funding in 


DEAMS to the NGIT Non-Supply Funding Document though a Work Order field in DEAMS to 


the FDUI in NexGen IT.  KSDs to be maintained in the official project folder are invoices, bills 


of material, labor cost reports, and other supporting documentation for costs. When the CA is an 


agency other than the USPFO, this process will be documented in a Memorandum of 


Understanding (MOU) with the CA.  


 


STEP 14:  The Construction Agent (CA/BCE) schedules the initial Project closeout 


meeting in accordance with ANG ETL 15-03, MILCON Project Closeout at approximately 75% 


complete.  Recommend all FSRM that require capitalization follow the same process.  (ANGI 


32-1023 & ANG ETL 15-03, MILCON Project Closeout) 
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STEP 15: Installation schedules facility turnover/final inspection meeting with the BCE, 


RPM, Contractor and stakeholders. This is the Placed-in-Service date that will be annotated on 


the Interim or Final DD Form 1354 (a KSD) (ANGI 32-1023, ANGETL 15-03, MILCON 


Closeout Process, Vol 4, Chapter 6 of the FMR, and UFC 1-300-08). 


 


STEP 16: The Construction Agent (CA), BCE, RPAO and RPM formally agree to place 


the real property in service on the interim DD Form 1354 with the CA signing in Block 24 and 


the delegated accepting official signing in Block 25 (ref. DAFI 32-9005,Vol 3, Chapter 17 of the 


FMR and UFC 1- 300-08). 


 


STEP 16.a.: Installation RPM captures all assets costs on the Interim DD Form 


1354 within 10 business days of Placed-in-Service date (ref. DAFI 32-9005 and Vol 4, 


Chapter 6 of the FMR).  The current capitalization threshold is $250,000. NexGen IT is 


currently configured to enforce this threshold and any records below the thresholds must 


be expensed i.e., E-Record. 


 


STEP 17: Construction Agent submits Final DD Form 1354 to BCE/RPM/USPFO 


within 18 months of Placed in Service date, after all punchlist items are complete and all costs 


are finalized. If the Capital Project is placed into a “Closed” status based on receiving a Final 


type DD Form 1354 no additional work can be done on this Capital Project.  Closed status is 


FINAL, meaning no additional DD Form 1354 could be added via the Capital Project used 


previously.  Help Desk cannot Un-Close a project.  An adjustment DD 1354 process would have 


to be done outside NexGen IT through the Real Property Manager or a new Capital Project 


created to add.  (NexGen Reference Guide for Real Property). 


 


 


STEP 17.a.: Installation RPM captures all costs or expenses appearing on the 


Final DD Form 1354 within 10 business days from the date the delegated accepting 


official signs the Final DD Form 1354 (a KSD) (ref. DAFI 32-9005 and Vol 4, Chapter 6 


of the FMR). 


 


STEP 18.: Construction Agent (CA) expenses all CIP costs not recorded on the Final DD 


Form 1354 (ref. Vol 4, Chapter 6 of the FMR).  


 


STEP 19: Installation RPM provides signed FINAL DD Form 1354 in NexGen IT Real 


Property Asset in Note/Documents tab, hard copy in Facility Folder and the Project Folder (ref. 


Vol 3, Chapter 17 and Vol 4, Chapter 6 of the FMR). 


 


5.  CAPITAL PROJECTS (CIP) FLOWCHART. A notional CIP flowchart is provided as 


attachment 1. This timeline shows how events in the CIP process relate to each other and 


provides a visual reference of when key events should occur within NexGen Projects Module. 


 


7. USE OF INFORMATION TECHNOLOGY SYSTEMS FOR CIP TRACKING. 


NexGEN IT will be the authoritative system of record for real property data and the DD Forms 


1354.  The ANG IT system for project management (Project Data System (PDS)) will prompt the 


generation of a DD Form 1354 (Draft, Interim, or Final) at the stage when it is required.  This 
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feature will be provided for NGB approval level projects only. When the project is programmed, 


the NGB/A4A Programmer will indicate in the Project Cost Breakdown, accessed from the 


Project Information Screen, with NGB/A4AIR recommendation whether the project is CIMP, 


DEMO or a Capital Project for CIP reporting (CONT). 


 


For projects that are determined to be capitalization (in full or in part), a PDS screen will appear 


displaying construction funding issued for that project, the percentage of the project that is to be 


capitalized, and DD Form 1354 fields to be populated by the base Real Property Manager (this 


will help the Programmer in creating the Opportunity in NexGen IT).  The BCE will be 


prompted to populate the appropriate DD Form 1354 version (Draft, Interim or Final) according 


to the project execution status.  Capital Project data is required for the DD Form 1354 to 


populate upon initial generation.  The Guide is set up to show all fields from the Cap Proj 


required for the 1354 process to work.  Information from other systems cannot be “imported” to 


NexGen IT and will not directly export data to any other systems, like PDS.   


 


This feature in PDS will allow the NGB/A4AIR personnel to see that DD Forms 1354 have been 


generated at the appropriate stage of project execution and will also provide a basis for 


comparing the project costs that have been capitalized or expensed with the project funding that 


has been provided. 


 
8. ACRONYMS:  
ANG – Air National Guard  


ANGI – Air National Guard Instruction  


APSR – Accountable Property System of Record 


BCE – Base Civil Engineer  


CA – Construction Agent  


CIP – Construction-in-Progress  


CSR – Construction Status Report  


DA – Design Agent  


DBCE – Deputy Base Civil Engineer  


DI – Design Instruction  


DoD – Department of Defense  


EDA – Electronic Documents Access  


FMR – Financial Management Regulation  


FIAR – Financial Improvement and Audit Readiness  


GLA – General Ledger Account  


KSD – Key Supporting Document  


MILCON – Military Construction  


NGB – National Guard Bureau  


NGB/A4A – Asset Management Division 


NGB/A4AIR – Real Property 


NGB/A4O – Operations Division  


PDS – Project Data System  


PM – Project Manager  


RPAO – Real Property Accountable Officer  


RPM – Real Property Manager  


RPSUID – Real Property Site Unique Identifier  
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RPUID – Real Property Unique Identifier  


SIOH – Supervision, Inspection, and Overhead  


SRM – Sustainment, Restoration and Modernization 


USPFO – United States Property Fiscal Officer 


WRRB – Work Request Review Board 


 


 


 


Attachments: 


1.  Capital Project (CIP) Flowchart 


2.  NexGen Projects P2IOC Guide 


3.  Key Supporting Documents Guide 







Opportunity


(unfunded Requirement)


Opportunity First Input by “Programmer”


ONLY required for generation of a Capital Project


For CONT and CIMP work


 Focus on detailed cost breakdown


ANG - NexGen IT – Flow Diagram for Projects (Requirements)


529, 321, 341


Unfunded Requirements (Opportunity)


Funded Requirements / Execution Phase


(Capital Projects)


Capital Project


(funded Requirement)


All Fields from Opportunity will transfer upon activation to the Capital Project


Req. data input on Capital Project by First User


Initiate NSFD from the Capital Project


DEAMS Transactions Flow back to the Capital Project based on the FDUI from the NSFD  


Initiate the DD Form 1354


‘Activation’


One time


Non-Supply Funding Document (NSFD)


Project Managers create a Draft-NSFD from the Capital Project by adding 3 fields (FY, PEC, EEIC) 


CE RA will complete and Activate NSFD


FDUI needs to be added to DEAMS 


DD Form 1354


Location data auto populates from the Capital Project


Manual Approvers SHALL be added


Upon BOD – Project Manager can complete Interim DD Form 1354


Upon Closeout – Project Manager can complete Final DD Form 1354 – Final Costs to Assets


Draft DD Form 1354 is available (only in Capital Project) 


BCE’s will initiate 1354 and route to NGB/A4AIR for NGB Program Manager to Input/Create the Opportunity


DEAMS


FDUI from NSFD added to Work Order field (before activation)


DEAMS Transactions flow back to the Cap Project based on FDUI / Project /PEC / EEIC


Installation


 Real Property Office (RPO)


DD Form 1354 Auto-Routes to RPO for first  ‘Approval’


Manual Approver is FINAL approver


Multiple Manual Approvers are allowed


RPO actions to update Real Property Records





Construction in Progress (CIP)


Based on Construction EEICs (320.13xx & 320.14xx)


Auto tracked based on DEAMS transactions  -or-


Tracked based on Manual Inputs using the Design Estimate and SIOH data fields on the Capital Project


General Ledger (GL)


Monthly reporting of CIP


One-time CIP adjustment


CIP $ to expense account or asset





















   
 



P a g e 1  



 



NexGen IT 



Air National Guard (ANG) 
 



Reference Guide 
Project Management 



Date: 30 October 2020 
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P a g e 2  
 



INTRODUCTION:  This Reference Guide supersedes any previous version. Refer to the NexGen IT 
Reference Guide Change Log below. 



FEEDBACK:  Contact us at tririgatraining@bah.com to provide feedback or to report errors in this 
Reference Guide.  



USEFUL LINK(S): 



NexGen IT Portal:  https://cs2.eis.af.mil/sites/10041/it_initiatives/nexgen_it/Pages/Homepage/aspx 



SYMBOLS USED: 



The ALERT! symbol indicates critical information.  



The NEW symbol will indicate any additional content following this publication release. 



Throughout this document, select this symbol when appropriate to navigate back to this NexGen IT 
Reference Guide Change Log. 



NEXGEN IT REFERENCE GUIDE CHANGE LOG 



The table below will continue to list significant changes made in this Reference Guide from the previous 
release. Select the Section Name to navigate to the new material within this Reference Guide. 



NEXGEN IT REFERENCE GUIDE CHANGE LOG 
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1.1 PROJECT MANAGEMENT IN NEXGEN IT  



 Introduction to Project Management in NexGen IT  



The Air Force Civil Engineer Center (AFCEC) Functional Management Office (FMO) developed NexGen IT 
Reference Guides to support users while completing daily in-system work activities. This guide was 
customized for Air National Guard (ANG)-specific processes to support Project Managers in completing 
the steps required to Capitalize ANG Projects in NexGen IT.   



This Guide communicates and familiarizes users with the step processes required to navigate the Project 
Management (PM) and Programming forms, objects, and modules within NexGen IT. For additional 
information on published guidance, policies, and business processes associated with Project 
Management, refer to the appropriately named/labeled playbook(s) provided by the ANG. This guide is 
presented in a role-based format enabling users to easily find and follow steps to complete specific 
processes.  The two roles presented in this Guide are the Programmer and Project Manager.  



To ensure an Air Force (AF) compliant, user-friendly experience, NexGen IT undergoes frequent 
configuration updates which may impact system interface and functionality. When updates occur, a 
critical message is released to the field describing the update and guide is modified to reflect the click-
stream changes. Please check the NexGen IT portal frequently for current training materials.   



This guide includes links to external documents. Please be aware that selecting an external link within 
the document may not work due to some Windows versions. To open external links, copy the URL and 
paste it into the web browser.   



For more information on general NexGen IT terms, processes, and basic system structure, please view 
the NexGen IT Basics Job Aid and the Introduction to NexGen IT Simulation 



Return to Table of Contents 
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 NexGen IT Project Management User Roles and Responsibilities 



To facilitate role-based permissions in NexGen IT, Engineering Flight personnel and those involved with 
the Flight are assigned to at least one of these roles based on their responsibilities. Users can hold both 
roles simultaneously, if needed. The following table lists the roles (and access rights) required for ANG 
Engineering Flight members:  



USER ROLES  SYSTEM ACCESS 



Programmer 



• Installation level 



• Opportunity Tabs and Sections 



• Opportunity Activation 



Project Manager 



• Installation Level 



• Capital Project Tabs and Sections 



• Non-Supply Funding Document(s) 



• DD Form 1354 



Return to Table of Contents 
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 Navigating the Programmer Portal 



 Once a user has logged into the system with the Programmer Role, the Programmer ‘Home’ 
portal displays. This is the default screen and contains several subsections for additional 
navigation and support: 



 The ‘My Opportunities – Programmer’ section provides a list of assigned Opportunities, 
allowing the user to directly access assigned requirements from the ‘Home’ portal 



 The ‘My Active Projects’ section lists all active funded requirements where the user is 
identified as the assigned Programmer 



 The ‘My Pending Projects’ section lists all pending funded requirements where the user is 
identified as the assigned Programmer 



NOTE:  More information on the ‘Reminders’ and ‘Related Links’ can be found in the NexGen IT 
Basics guide.  



 



Programmer Home Portal 



  





https://cs2.eis.af.mil/sites/10041/it_initiatives/nexgen_it/Related%20Resources%20Library/NexGen%20IT%20Basics.pdf
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 To Navigate to the ‘Opportunities’ section: 



 Select the ‘Maintenance’ tab 
 Select the drop-down arrow next to ‘Facility Assessment’  
 Select ‘Manage Opportunities’ from the drop-down menu; a table displays 



 



Navigation to the Opportunities Section  



 On the ‘Manage Opportunities’ table is an expanded list of all Opportunities for the Installation. 



 Select ‘Query’ fields to search opportunities  
 Select ‘Add’ to create new opportunities, ‘Copy’ to create copies, and ‘Delete’ to remove 



Opportunities from the system 



NOTE:  Proceed to 2.0 Project Management – Programming in NexGen IT in this guide for more 
details on system functionality for programming in NexGen.   



 



Manage Opportunities Query Page 



Return to Table of Contents 
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 Navigating the Project Manager Portal 



 Once a user has logged into the system with the Project Manager Role, the Project Manager 
‘Home’ portal displays. This default screen contains several subsections for additional navigation 
and support: 



 The ‘My Active Projects’ section lists all active funded requirements assigned to the Project 
Manager, allowing direct access to assigned requirements from the ’Home’ portal. 



 The ‘My Pending Projects’ section lists all pending funded requirements assigned to the 
Project Manager, allowing direct access to assigned requirements from the ’Home’ portal. 



NOTE:  More information on the ‘Reminders’ and ‘Related Links’ can be found in the NexGen IT 
Basics Job Aid.  



 



Project Manager Home Portal 



  





https://cs2.eis.af.mil/sites/10041/it_initiatives/nexgen_it/Related%20Resources%20Library/NexGen%20IT%20Basics.pdf
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 To Navigate to the ‘All Capital Projects’ section: 



 Select the ‘Projects’ tab  
 Select the ‘Capital’ sub tab; a new table appears in the window that replaces ‘My Pending 



Projects’ with ‘All Capital Projects’. 
 Select the ‘Maximize’ button on the table to view an expanded Capital Projects list. 



 



Capital Project Section Navigation  



 On the ‘All Capital Projects’ table search for specific projects using the ‘query’ fields (1) 



NOTE: Section 3.0 ANG Project Management NexGen IT Project Execution of this guide 
provides details for system functionality on project management in NexGen IT.  



 



Home > Projects 



Return to Table of Contents 
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2.1 ANG PROJECT MANAGEMENT – PROGRAMMING 



Project Programming and Execution occurs in separate areas of NexGen IT: The Opportunity and the 
Capital Project. NexGen IT enables the development of new requirements called Opportunities and 
execution of those requirements as Capital Projects. This interaction connects Opportunities to Real 
Property and the eventual linkage of Financial Management with the Capital Projects.   



For the Air National Guard, Programming of Opportunities will be limited to support the generation of 
Construction and Capital Improvement type requirements which requires Capitalization in the Real 
Property Records throughout the use of the Capital Project. 



 



Return to Table of Contents 
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2.2 CREATING AN OPPORTUNITY 



An Opportunity can be created using the ‘Add’ button or from an existing Opportunity by using the 
‘Copy’ button. 



New Opportunities are created in the system, as outlined in Section 2.2.1 ‘Creating a New Draft 
Opportunity’ of this guide. This method covers new requirements for MILCON and FRSRM projects.  



Additionally, this guide provides step-by-step processes for adding data into NexGen IT. A Programmer 
user role is needed to add information when creating new Opportunities. Please refer to AFCEC or ANG 
Programming guidance for detailed business process rules. Opportunity sections are presented in order 
of appearance in NexGen IT and follow the tab and fields order as close as possible.  



Some fields in NexGen IT, indicated by a red border and warning “Do Not Use”, are visible but unusable 
and must not have data entered or changed in that field. DO NOT add or change any data on these tabs. 



Example: The EEIM, System, Workflow Instance, Associations, and Audit tabs on an Opportunity are not 
currently in use in NexGen IT.   



 



The following sections of this Reference Guide describe step processes for creating new Opportunities 
and completing data fields on each tab and section of the Opportunity. 



NOTE: NexGen IT does not have autosave functionality. It is best practice to save work often to 
avoid losing data. Data is only committed to the database when selecting ‘Save’ or ‘Save & 
Close’. 



Return to Table of Contents 
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 Creating a New Draft Opportunity 



An Opportunity in NexGen IT has six, system-required fields that must be populated before selecting the 
‘Create Draft’ button, which generates a new draft Opportunity. Populating data in an Opportunity is an 
iterative process as all the required data may not be available when initially creating the Opportunity. 
The following steps support a process to create the Opportunity with minimal data and then iteratively 
add and save data to the Opportunity.   



To create a Draft Opportunity in NexGen IT, the Programmer performs the following steps: 



 From the ‘Home’ portal:  



 Hover over the ‘Maintenance’ tab  
 Select the ‘Facility Assessment’ drop-down arrow  
 Select ‘Manage Opportunities’ from the drop-down menu; the ‘Manage Opportunities’ 



window displays  



 



Programmer Home Portal>Maintenance Tab>Facility Assessment Drop-down>Manage Opportunities  



 From the ‘Manage Opportunities’ window, select ‘Add’; an ‘Opportunity’ page opens 



 



Manage Opportunities Page>Add Button 
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 On the ‘General’ tab, in the ‘General’ section of the ‘Opportunity’: 



NOTE: ‘ID’ & ‘Status’ fields are empty and auto-populate after ‘Create Draft’ is selected. The Opportunity 
ID number is system-generated and not editable. The ID number is used for all references to the 
Opportunity business object.   



 Enter a name for the Opportunity in the ‘Name’ field 
 Select the ’Execution Method’ drop-down arrow and select ‘Capital Project’ from the drop-



down menu 



NOTE:  Selecting any other option for ‘Execution Method’ will not generate a Capital Project at 
Opportunity Activation  



 In the ‘Opportunity Type’ field, verify the default value appears as ‘Deficiency’  



 



Blank Opportunity Form 
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 In the ‘Detail’ and ‘Dates’ sections of the Opportunity ‘General’ tab: 



 In the ‘Detail’ section, ‘Installation Name’ field, select the ‘Search’ icon to choose the 
‘Installation Name’; both ‘Installation Name’ and ‘MAJCOM Name’ auto-populate.   



NOTE: For Users at the installation level, selecting the ‘Search’ icon auto-populates the 
Installation and MAJCOM Names. Users at higher levels (AFCEC, ANG, HAF, MAJCOM) must 
select from the query list to populate these fields. 



 In the ‘Dates’ section, validate the ‘Currency’ field default is “US Dollars” and the ‘Quantity 
Units’ fields defaults are “Quantity” and “each”. Do not change the default values.  



 Select ‘Create Draft’ to generate the new Draft Opportunity. The screen refreshes, the ‘ID’ 
and ‘Status’ fields auto-populate and the ‘Create Draft’ button is replaced with a new 
selection of buttons (‘Activate’, ‘Save’, and ‘Save & Close’) used later in the process. 



 



Blank Opportunity Form 



Return to Table of Contents 
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2.3 OPPORTUNITY LIFECYCLE 



The following sections provide step-by-step guidance for users with the Programmer User Role to 
complete Opportunity data fields in NexGen IT. Opportunity tabs and sections are presented in order of 
appearance in NexGen IT and the fields presented follow the tab order as close as possible; however, 
the user may complete in any order they choose. ANG users have fewer fields to populate than the tab 
order, so navigate using the tab name, section name, and data field title. 



 Completing the General Tab 



The ‘General’ tab comprises several sections which contain most of the data, description, cost 
breakdown, program, and units involved for an Opportunity. The following sections detail each of the 
NexGen IT sections and the corresponding fields.  



 



Opportunity>General Tab 



Return to Table of Contents 
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2.3.1.1 Completing the General Section 



Following the Create Draft Opportunity steps defined in Section 2.2.1, a new Opportunity in NexGen IT 
contains populated fields that are ready for further programming.  After creating a draft opportunity 
(defined in Section 2.2.1), the newly created opportunity contains additional fields that require further 
programming. 



NOTE: NexGen IT Opportunity screens show some out-of-the-box fields not in use. This guide 
identifies these fields with a red bordered box and warning text, “Do Not Use” inside the box. 



To complete programming an Opportunity in NexGen IT, use the following steps: 



 On the ‘General’ tab, ‘General’ section: 



 The ‘Name’ field is an alphanumeric text field allowing up to one hundred characters to be 
entered 



  The ‘Description’ field is an alphanumeric text field that allows up to one thousand 
characters 



  The ‘Fiscal Year’ field is entered in the “FY” (YYYY) format for the planned fiscal year of the 
funding of the Opportunity  



  In the ‘Program Type’ field, select the drop-down arrow to choose a Program Type from the 
drop-down menu. This field transfers to the Capital Project upon Opportunity Activation. 



 



General Section>Description, Fiscal Year, and Program Type Fields 



 Validate the ‘Execution Method’ is “Capital Project” 



NOTE: Only an Opportunity with an Execution Method of “Capital Project” produces a Capital 
Project upon activation of the Opportunity. Execution Method of “Facility Project”, “Purchase 
Order”, or “Service Agreement” will not generate a Capital Project. 
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General Section>Execution Method 



 In the ‘Program (PEC)’ field: 



 Enter the Program (PEC) manually or, select the ‘Search’ icon to open the table 
 Select the radio button for the appropriate ‘Program PEC’ from the open table 
 Select ‘OK’ 



NOTE:  An Opportunity can have multiple PECs. The ‘General’ section ‘Program PEC’ field is used 
for the predominate PEC. If this field is left blank, a red asterisk appears at Opportunity 
Activation indicating the field is required to continue the activation process. 



 



General Section>Program (PEC) 



 In the ‘Cost Element Code (EEIC)’ field: 



 Enter the Cost Element Code (EEIC) manually, or select the ‘Search’ icon to open the table, 
then select the radio button for the appropriate ‘Cost Element Code (EEIC)’  



  Select ‘OK’ 



NOTE:  An Opportunity can contain multiple EEICs. The ‘General’ section ‘EEIC’ data field is used 
for the predominate EEIC. If this field is left blank, a red asterisk appears at Opportunity 
Activation indicating the field is required to continue the activation process. 
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General Section>Cost Element Code (EEIC) 



 The ‘Base Justification’ field is an unlimited length alphanumeric text field. 



 



General Section>Base Justification Field 



 Validate the following: 



 The required ‘Opportunity Type’ field defaults to “Deficiency”. ANG will not need to change 
the type. 



  The ‘Project Number (Legacy)’ field is blank for new Opportunities created in NexGen IT 



NOTE:  The ‘Project Number (Legacy)’ field may be used at the installation level and is manually 
input with an alphanumeric value. ANG business process may dictate what value to use.   



 



General Section>Opportunity Type>Project Number (Legacy) 



This completes the initial programming actions on the ‘General’ tab in the ‘General’ section. 



Return to Table of Contents 
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2.3.1.2 Completing the Financial Section 



In NexGen IT, on the ‘General’ tab, follow these steps to complete the ‘Financial’ section of an 
Opportunity as needed: 



 Select the ‘Funding Status’ drop-down arrow to choose the appropriate option from the drop-
down menu 



 



Financial Section>Funding Status 



 In the ‘Funds Requested Date’ field, select the date using the ‘Calendar’ icon or manually enter 
the date in the field using the date MM/DD/YYYY format. 



 



Financial Section>Funds Requested Date 



This completes the initial programming actions on the ‘General’ tab in the ‘Financial’ section. 



 Return to Table of Contents 
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2.3.1.3 Completing the Detail Section 



 To complete the ‘Detail’ section of the ‘General’ tab of an Opportunity in NexGen IT, the 
Programmer must perform the following steps: 



NOTE:  Do not use the ‘Standard Title’ field. If text is entered in this field, the ‘Name’ field in the 
‘General’ section is overwritten with the ‘Standard Title’ data. 



 



Detail Section>Standard Title 



 In the ‘Unit requesting project’ field: 



 Select the ‘Search’ icon to open the projects table, then select the radio button for the 
appropriate “Unit requesting project” 



 Select ‘OK’, the table closes 



 



Detail Section>Unit Requesting Project Selection Window 



  



Do Not Use 
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 In the ‘Command’ field: 



 Select the ‘Search’ icon to open the table, then select the radio button to choose the 
appropriate Command selection 



 Select ‘OK’  



 



Detail Section>Command Selection Window 



 In the ‘Requiring Command’ field: 



 Select the ‘Search’ icon; a table opens. Select the appropriate radio button to choose the 
‘Requiring Command’ 



 Select ‘OK’  



 



Detail Section>Requiring Command Field 
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 In the ‘Detail’ section, ‘Wing Number’ field: 



 Select the ‘Search’ icon to open the table, then select the appropriate ‘Wing Number’ radio 
button  



 Select ‘OK’  



 



Detail Section>Wing Number Selection Window 



Installation Name and MAJCOM Name were populated during the creation of the new Opportunity in 
section 2.2.1 of this guide. 



This completes the initial programming actions on the ‘General’ tab in the ‘Detail’ section. 



Return to Table of Contents 
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2.3.1.4 Completing the Locations Section 



To associate the Opportunity to an existing asset (asset with an RPUID) in NexGen IT, perform the 
following steps: 



NOTE: If an asset is new, i.e. new construction, coordinate with the Real Property Office to add a 
‘Proposed Asset’ to NexGen IT. 



 In the ‘Locations’ section: 



 Select ‘Find’ to search for the existing or proposed asset(s), a window appears 
 Select the ‘Checkbox(s)’ next to the appropriate asset(s) 
 Select ‘OK’ on the open window 
 After locations are populated in the ‘Locations’ section, select ‘Save’ on the Opportunity  



 



Locations Section>Find & Select Asset 



This completes the initial programming actions on the ‘General’ tab in the ‘Locations’ section 



Return to Table of Contents 
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2.3.1.5 The Capital Project Section 



The ‘Capital Project’ section of the Opportunity only displays the associated Capital Project after the 
Opportunity is activated. If a link is visible in this section, the Opportunity is activated. 



 



General Tab>Capital Project Section 



Return to Table of Contents 
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2.3.1.6 Completing the Cost Section 



The Programmer role can complete this section with the following steps: 



 In the ‘Cost’ section,  



 The ‘Quantity’ field defaults to ‘1’. Do not change the Quantity field; this number acts as a 
multiplier of the ‘Estimated Cost Per Unit.’ 



 In the ‘Estimated Cost Per Unit’ field, enter the cost associated with the Opportunity 
 In the ‘Total Other Costs’ field, enter the total other costs of the Opportunity 
 In the ‘Unfunded Amount’ field, enter the unfunded amount of the Opportunity  



The ‘Total Estimated Cost’ field is auto calculated from the sum of the ‘Estimated Cost Per Unit’ 
and the ‘Total Other Costs’ Fields. The ‘Total Estimated Cost’ field is the value referenced in the 
next section,2.3.1.7. 



 



Cost Section>CE>Estimated Cost Per Unit 



Return to Table of Contents 
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2.3.1.7 Completing the Opportunity RPUID Cost Breakdown Section 



The Location line item(s) from section 2.3.1.4 are added to the ‘RPUID Cost Breakdown’ section. Each 
location on the list has associated ‘Program Element Code’ (PEC), ‘Cost Element Code’ (EEIC), ‘Project 
Type Code,’ and ‘RPUID Cost Total’ fields.   



NOTE:  ANG should complete this section of the Opportunity to include all potential ‘Locations’ 
impacted by the requirement. ‘Locations’ include all asset types, i.e. underground utilities, roads, 
parking lots (Linear Structures). 



 To complete this section, follow these steps: 



 Validate all line items in the ‘Locations’ section (reference 2.3.1.4) are showing on the 
‘Opportunity RPUID Cost Breakdown’ section. If not showing select the ‘Save’ button to 
refresh the page and initiate system workflows.  



 In the Program Element Code (PEC) field, enter the PEC by typing manually or select the 
‘Search’ icon and select the radio button for the correct ‘PEC’, then select ‘OK’ 



 Select the ‘Cost Element Code (EEIC)’ by entering the EEIC manually or select the ‘Search’ 
icon and select the radio button for the correct EEIC, then select ‘OK’ 



 Select the ‘Project Type Code’ then select the ‘Search’ icon to choose from the query list 
 In the ‘RPUID Cost Total’ field, enter the amount attributed to the location 



NOTE: The ‘RPUID Cost Total’ must be broken down to the cent level and the sum must equal 
the ‘Total Estimated Cost.’ RPUID Cost Percent field is calculated by NexGen IT from the ‘RPUID 
Cost Total’ field values. The ‘RPUID Cost Percent’ defaults to 100 percent for each location on 
the list and updates automatically when the user enters the RPUID Cost Total for each location. 
If the ‘RPUID Cost Percent’ totals to more than 100.00, an Attention! message appears at the 
top of the Opportunity.  



 



Opportunity>RPUID Cost Breakdown Screen  
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 To add multiple instances of a facility, follow these steps: 



 Select the ‘Checkbox’ in the ‘Opportunity RPUID Cost Breakdown’ section associated to the 
Location 



 Select the ‘Copy’ link in the ‘Opportunity RPUID Cost Breakdown’ section to create a copy of 
the row; a new row is added for the highlighted Location 



NOTE: If multiple instances of a location were inadvertently added, select the ‘Checkbox’ in the 
left column then select the ‘Remove’ link in the ‘Opportunity RPUID Cost Breakdown’ section 
header. The row is removed.   



 



Opportunity>General Tab>Opportunity RPUID Cost Breakdown 



Return to Table of Contents 
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 Completing the Contacts Tab 



The ‘Contacts’ tab on the Opportunity supports workflows in NexGen IT and provides a listing of people 
who are involved with the Opportunity.   



 To add contacts to an Opportunity, complete the following steps: 



 Select the ‘Contacts’ tab and navigate to the ‘Contacts’ section 
 Select the underlined role name to assign a person; the ‘Contact’ role window appears 



NOTE: There are three NexGen IT system required contacts (see screen capture). Names can be 
changed, but the three required contact roles cannot be removed. If any default roles are 
removed, the next ‘Save’ action adds the missing role(s) back to the list. An Opportunity will not 
activate if contacts are missing. Contacts will transfer to the Capital Project upon ‘Activation’. 



 



Opportunity Form>Contacts Tab 



 In the ‘Contact Role’ window: 



 In the ‘Name’ field, enter the name of the person. The name must be selected from the list 
of active NexGen IT users. The user’s information populates in the ‘Contact’ section and 
serves as validation the selection was completed successfully.  



 Select ‘Save & Close’ to close the ‘Contact Role’ window and return to the Opportunity, 
‘Contacts’ tab. The assigned person in the Contacts list is now visible. 



 



Opportunity Form>Contact Role Window 



 Repeat steps until all contact roles are assigned. 
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2.4 ACTIVATING AN OPPORTUNITY 



Activating the Opportunity is done by selecting the ‘Activate’ button on the Opportunity. The ‘Activate’ 
button is a one-time use button. Once the ‘Activate’ button is selected for Opportunities with an 
Execution Method of Capital Project, a new Capital Project is generated, the Opportunity is placed into 
an Active status, and the new Capital Project ID appears in the ‘Capital Project’ section of the 
Opportunity. If the Activation was an accident, the user must re-program, or Copy (Section 2.5 of this 
guide) the activated Opportunity, to create a new Opportunity as NexGen IT cannot undo an Activation. 
Additionally, once activated, changes to an Opportunity in Active status are not reflected in the 
associated Capital Project. 



 Activating a Draft Opportunity 



 On the Opportunity, select the ‘Activate’ button to create an associated Capital Project. 



NOTE:  Ensure all system required fields are populated before the ‘Activate’ button is selected, 
or a warning message appears at the top of the screen as an ‘Attention!’ message.  



 



Opportunity Form>Activate Button 



 Once the Capital Project is created, open the Opportunity and view the Capital Project 
associated to the Opportunity. See section 2.3..1. 



 



Opportunity Form>Capital Project Section 
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 Completing the Opportunity 



After an Opportunity is Activated to a Capital Project, select the 'Complete' button in the Opportunity. 
The 'Complete' status removes the Opportunity from the active list of requirements in NexGen IT.  



 



Opportunity Form>Active Status – Complete Button 
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2.5 COPY OR DELETE AN OPPORTUNITY 



The ‘Copy’ button supports duplication of any existing Opportunity in any status (Draft, Active, Retired 
or Completed). The ‘Copy’ button duplicates a pre-determined list of fields (see Appendix B) from the 
source Opportunity to a new ‘DRAFT’ status Opportunity with "Copy of" appended to the beginning of 
the Opportunity Name. Note that not all fields are copied. 



The ‘Delete’ button provides users a method to remove unwanted or unneeded Opportunities. Only 
Opportunities in a Draft status can be deleted. 



The ‘Copy’ and ‘Delete’ buttons are only visible for NexGen IT Programmer User Role. 



 Copy an Opportunity 



To copy an ‘Opportunity, use the following steps: 



 On the Opportunity Query table:  



 Use search fields, or column headers to filter results to locate the Opportunity to copy   
 Select the checkbox next to the desired Opportunity; the checked Opportunity becomes the 



source Opportunity to copy 
 Select ‘Copy’; a new copy of an Opportunity is created 



 



Opportunity Query Screen 



 The new ‘Opportunity’ field now shows the new ID number, the words “Copy of” before the 
name and status show as “Draft”. 



Opportunity Table>Copy of 
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 Edit the copied Opportunity to remove “Copy of” from the name field, then complete 
programming actions as required. 



NOTE:  Location and RPUID Cost Breakdown sections DO NOT COPY and must be populated for 
each new Opportunity.



 Delete an Opportunity 



To delete an Opportunity, use the following steps: 



  On the Opportunity query screen,  



NOTE:  Only an Opportunity in a Draft status can be deleted. 



 Search for the Opportunity in ‘Search’ fields, then select the checkbox(s) next to the 
Opportunity to delete. 



 Select ‘Delete’  



 



Opportunity Query Screen 



 On the ‘Confirm Delete:’ window pop-up, see the ‘Attention!’ section: 



 Validate the correct Opportunity ID number(s) are displayed 
 Select ‘Continue’ to delete the selected Opportunity 



NOTE:  Select “x” to return to the Opportunity Query Screen and cancel the deletion. Once an 
Opportunity is deleted, it cannot be recovered, and data is erased from NexGen IT.  



 



Confirm Delete: window 
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3.1 INITIATING A CAPITAL PROJECT 



Upon activation of an Opportunity, NexGen IT creates a Capital Project. The Project Manager user role is 
required to enter information in the fields to begin managing the new Capital Project. The following 
sections of this ANG specific guide covers completing specific fields of the Capital Project to allow 
NexGen IT to properly track and record Construction and Capital Improvement projects.  



Return to Table of Contents 
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 Adding Project Type Code 



Upon opening a Capital Project for the first time, the ‘Save’ button will not function until the ‘Project 
Type Code’ on the RPIM tab is populated. To add the ‘Project Type Code’ to the Capital Project, use the 
following steps: 



 Open the Capital Project: 



 Select the ‘RPIM’ tab 
 Select the ‘Project Type Code’ ‘Search’ icon to search for the Project Type Code or type the 



code into the field. For ANG, this will be either ‘CONT’ for Construction or ‘CIMP’ for Capital 
Improvement. 



 



Capital Project>RPIM Tab>Project Type Code 



 Select the appropriate “Project Type Code” from the list 



 



Capital Project>RPIM Tab>Project Type Code 



NOTE:  If “CIMP” (Capital Improvement) is selected, then the ‘Capital Improvement’ section is 
required to be filled out. See section 3.2.2.3 for information on filling out additional fields of the 
‘RPIM’ tab. 



 Scroll to the ‘Property Work Action’ section and delete the data in the ‘Work Order Number’ 
Field. This value is populated with the Capital Project ID number but is not required and will require 
additional data to be entered if left populated. Select the ‘Save’ button. 
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3.2 CAPITAL PROJECT LIFECYCLE MANAGEMENT 



When an Opportunity is Activated into a Capital Project, data must be validated to ensure all 
information transferred from the Opportunity is current. Additional data is also required for the Capital 
Project to accurately track costs. The following sections of this guide provide the step processes for ANG 
Project Managers to populate data for Capital Projects. 



 Completing the General Tab 



The Capital Project contains multiple tabs for completing project requirements, but the ‘General’ tab is 
the primary source of information for the Capital Project. The sections contain data fields to input a 
variety of information such as names, descriptions, and dates. A large portion of this data migrates from 
an activated Opportunity. Verify the data in the sections are complete and provide additional data as 
needed. Sections 3.2.1 thru 3.3.4 in this guide show how information is input into NexGen IT.  



3.2.1.1 Completing the General Section 



 To populate the ‘General’ section of the ‘General’ tab, complete the following steps: 



 The ‘ID’ field auto-populates on creation of the Capital Project and the status defaults to 
“Draft” 



 The ‘Date’ field auto-populates with the date the Opportunity was Activated 
 The ‘Fiscal Year’ field auto-populates from the Opportunity 
 The ‘Name’ and ‘Project Description’ fields auto-populate from the Opportunity 



 



Capital Project General Tab>General Section 
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 The ‘Retirement Reason’ field can be used to provide a reason for retiring a Capital Project.  
Retirement Reasons include: Canceled, Change in Mission, Completed, and Project on Hold. 
Populating this field alone, does not Retire the Capital Project. To select a Retirement Reason: 



 In the ‘General’ section, ‘Retirement Reason’ field, use the drop-down arrow to select from 
the drop-down menu 



 In the ‘Retirement Date’ field, select the date the Capital Project is retired (the date is not 
automatically entered when a Capital Projects is retired). The date can be entered manually 
or use the ‘Calendar’ icon to select a date.  



 



General Tab>General Section>Retirement Reason and Retirement Date 



NOTE:  A Capital Project is not placed into the ‘Retired’ status until the user selects the ‘Retire’ 
button in the top right of the form. The Capital Project is then removed from the Capital Projects 
full listing and is only be accessible using a report. A user can ‘un-retire’ the Capital Project by 
opening the Retired Capital Project from a report and selecting the ‘un-retire’ button.  



NOTE: Capital Projects in a ‘Draft’ status cannot be retired.  



  



General Tab>More Menu>Retire 
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3.2.1.2 Completing the Details Section 



 In the ‘Project Type’ field, the ‘Project Type’ auto-populates from an Activated Opportunity 
(Program Type field – General tab/General section.) The user can validate or modify this field by 
selecting the ‘Project Type’ drop-down arrow and selecting the appropriate ‘Project Type’ from 
the drop-down menu to best represent the type of project. 



 



General Tab>Details Section>Project Type 



 Verify the ‘Project Number (Legacy)’ field auto-populated from the Opportunity. 



 



General Tab>Details Section>Project Number (Legacy) 



 The ‘Used for RPIM Reporting’ checkbox should ALWAYS contain a check mark. If the checkbox 
is empty, select the checkbox to place the check mark in the box then select ‘Save’. 



 



General Tab>Details Section>Used for RPIM Reporting 



 The ‘Program (PEC)’ field auto-populates from an Activated Opportunity. Validate or modify the 
Program (PEC) by entering the PEC or selecting the ‘Search’ icon to open the list.  



 



General Tab>Details Section>PEC 
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 The ‘Cost Element Code (EEIC)’ field auto-populates from an Activated Opportunity. Validate or 
update the EEIC by entering manually or selecting the ‘Search’ icon to choose from the list. 



 



General Tab>Details Section>Cost Element Code (EEIC) 



 The ‘Base Justification’ field auto-populates from an Activated Opportunity and can be modified 
if required 



 



General Tab>Details Section>Checkboxes 



 The ‘Unit Requesting Project’, ‘Command’, ‘Requiring Command’, ‘Host Command’, and ‘Wing 
Number’ fields auto-populate from an Activated Opportunity. Modify as necessary by entering 
in a value manually or selecting the ‘Search’ icon to choose from the list 



 



General Tab>Details Section>Unit Requesting Project – Wing Number 
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 The ‘Control Installation’ field and ‘MAJCOM Name’ field will auto-populate from the activated 
Opportunity or when the ‘Search’ icon for ‘Control Installation’ is selected. 



 



Control Installation and MAJCOM Name 
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3.2.1.3 Completing the Design and Construction Section 



To complete this section, follow these steps: 



 In the ‘Design and Construction’ section, ‘Design Estimate’ field, enter the estimated cost to 
complete the design 



 In the ‘Supervision, Inspection, & Overhead (SIOH)’ field, enter the amount of SIOH funds 
needed for the design and construction agent 



Note: These two data fields (‘Design Estimate’ and ‘SIOH’) will add to the costs used in the 
RPUID Cost Breakdown sections. 



 



General Tab>Design and Construction Section>Design Estimate, SIOH,  
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3.2.1.4 Completing the Funding Document Section 



Capital Projects require a Non-Supply Funding Document, which captures all cost elements to ensure the 
ANG can properly attribute financial data to transactions within DEAMS to NexGen IT. Activation of a 
Non-Supply Funding Document generates the required cost code structure within NexGen IT to apply 
related expenses and transactions for the Capital Project. Non-Supply Funding Documents are created to 
show funding provided for certain activities, automated tracking of expenses to date, and to establish 
the foundation for expenses to be concurrently tracked with the AF Financial System (DEAMS) through 
system interfaces to NexGen IT.  



A Non-Supply Funding Document can only contain one Program Element Code (PEC). If a Capital Project 
involves multiple PECs, the user must create a Non-Supply Funding Document for each PEC. Non-Supply 
Funding Document may contain multiple Cost Element Codes (EEIC). 



To create a Non-Supply Funding Document for a Capital Project Activated from a Capital Project, the 
Project Manager will complete the following steps: 



 In the ‘Funding Document’ section of the Capital Project, select the ‘Add’ link. A new Funding 
Document window/object opens 



 



General Tab>Funding Document Section>Add 



 In the ‘General’ section of the Non-Supply Funding Document: 



 The ‘FDUI’ and ‘Status’ fields auto-populate when ‘Create Draft’ is selected 
 ‘Installation Code’, ‘Installation Name’, and ‘MAJCOM Name’ fields auto-populate 
 In the ‘Name’ field, the name of the Capital Project auto-populates 
 The ‘Date’ field auto-populates with the current date 
 The ‘Funding Document Type’ field defaults to “Non-Supply” 
 The ‘Funding Document Purpose’ field defaults to “P - Capital Project” or If a MILCON Capital 



Project, update the ‘Funding Document Purpose’ field to reflect “M-MILCON” 



 



Funding Document>General Tab>ID, Status, Installation Code, Installation Name, MAJCOM Name, 
Name, Date, Funding Document Type, and Funding Document Purpose 
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 In the ‘Associated Project’ section of the Non-Supply Funding Document, the associated Capital 
Project auto-populates. 



 



Funding Document>General Tab>Associated Project Section>Find 



 In the ‘Budget Fiscal Year’ section of the Non-Supply Funding Document, enter the Fiscal Year of 
the funds AND select the correct fiscal year from the list which appears below the data field for 
NexGen IT workflows to function.  



 



Funding Document>General Tab>Budget Fiscal Year Section>Budget Fiscal Year 



 In the ‘Program’ section, enter the Program (PEC) in the ‘Program (PEC)’ field for the Capital 
Project or use the query icon to look up the correct PEC, select the radio button, then ‘OK’. 



NOTE: Only ONE ‘Program (PEC)’ per Non-Supply Funding Document.   



 



Funding Document>Program section>Program (PEC) 



 In the ‘Elements Of Accounting’ section of the Funding Document, select the ‘Add’ link to add 
the ‘Cost Element Code’; a new Funding Document Line Item: window/object opens. 



 



Funding Document Line Item>Elements Of Accounting Section 



  











 



P a g e 47 
Section 3.2.1.4 Completing the Funding Document Section 



 Scroll down to the ‘Cost Element Code’ section in the ‘Funding Document Line Item’ window, 
enter in the correct ‘Cost Element Code (Expense Type)’ or use the query icon to look up the 
‘Cost Element Code’, select the correct radio button, then select ‘OK’ button.  



NOTE: Do not modify any other sections or fields on the ‘Funding Document Line Item’ 
window. These fields are for the Financial Manager role to update/populate. Cost Element 
Codes do not auto-populate from the Capital Project.  



 



Funding Document Line Item>Cost Element Code>Cost Element Code (Expense Type) 



 On the ‘Funding Document Line’ Item window, select ‘Create Draft’. 



NOTE: Process is two steps (Create Draft and Save & Close). 



 



Funding Document Line Item>Cost Element Code>Create Draft 
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 Select ‘Save & Close’ on the Funding Document Line Item. 



 



Funding Document Line Item>Cost Element Code>Save & Close 



 



Funding Document>Elements Of Accounting Section 



 Repeat steps 9 - 10 for each additional ‘Cost Element Code’ required on the Capital Project. 



 Select ‘Create Draft’ on the Funding Document to generate the Non-Supply Funding Document. 



 



Funding Document>Create Draft  
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 Select ‘Save & Close’ to return to the Capital Project. 



The Summary section of an Active Non-Supply Funding Document (NSFD) displays the ‘Budgeted 
Amount’ for the Capital Project and a summary of DEAMS Transaction amounts. 



 



Funding Document>General Tab>Summary Section>Budgeted Amount, UOO, AEU, and AEP 



The Financial Manager completes the lines of accounting, adds the funding amount, and activates the 
NSFD so the Funding Document appears as “Active”. 



NOTE: The Funding Document must be in “Active” status to complete a Standard Contract in 
NexGen IT. 



 Navigate to the ‘Transactions’ tab of an Active Funding Document to view any DEAMS 
Transactions. 



 



Funding Document>Transactions tab>DEAMS Transactions section 



RETURN TO TABLE OF CONTENTS 
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3.2.1.5 Reviewing the RPUID Cost Breakdown Section  



 Validate the RPUID Cost Breakdown Section of the Capital Project transferred correctly from the 
Opportunity. The Program Element Code (PEC), Cost Element Code (EEIC), and Project Type code 
data fields auto-populate; however, costs do not transfer from the Opportunity, only the RPUD 
Cost Percent fields. The RPUID cost total fields are populated from the Non-Supply Funding 
Document linked to the Capital Project.   



NOTE: The user is responsible for entering percentages for Construction-in-Progress (CIP) and 
Work-in-Progress (WIP) for projects with construction or capital improvement.  



 



General Tab>RPUID Cost Breakdown Section 



 After completing the ‘Design and Construction’ section (3.2.1.3), validate the appropriate costs 
are transferred to the ‘RPUID Cost Total' column. 



 The sum of the ‘CIP Cost Percent’ breakdown must equal exactly 100.00 Percent total across all 
Locations listed with a Construction or Capital Improvement Program Element Code (PEC) and 
Cost Element Code (EEIC) project.   



 WIP (Work In Progress for non-federal facilities, i.e. Credit Unions, standalone restaurants, etc.) 
is rarely used and needs to be updated as the NexGen IT defaults to 100.00 percent. (zero is an 
acceptable value). 



 ‘RPUID Cost Percent’ fields need to be updated to sum up to 100.00 percent across both ‘Non-
Construction’ and ‘Construction RPUID Cost Breakdown’ sections.   



 If there are multiple Program (PEC) or multiple Cost Element Codes (EEIC) being used in the 
Capital Project, additional lines may need to be added in either or both of the ‘RPUID Cost 
Breakdown’ sections. If the Opportunity was programmed correctly, the values will migrate to 
the Capital Project with Locations containing multi PEC or EEIC. 



 For each Location listed in these sections, multiple PEC or EEIC can be added if required by first 
selecting a checkbox in the far-left column. 



 In the ‘RPUID Cost Breakdown’ section headers, select the ‘Copy’ link. 



 A new row associated to the location is visible and ready for updating information. 



 Complete steps 5-7 for each new row required. 



RETURN TO TABLE OF CONTENTS
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3.2.1.6 Locations Section 



 Validate ‘Locations’ section auto-populated with data from the Activated Opportunity.   



NOTE: If additional locations are needed, follow the process mentioned in section 2.3.1.4. to 
add locations to this Capital Project. As additional locations are added, select ‘Save’ for the 
‘RPUID Cost Breakdown (Non-Construction)’ section to update with the recently added location. 
Also, trying to add the Locations to the Opportunity post activation will not add the Location to 
the Capital Project. Any additional locations must be added to the Capital Project.  



 



General Tab>Locations Section 



RETURN TO TABLE OF CONTENTS
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3.2.1.7 Opportunity Section 



The ‘Opportunity’ section displays the Opportunity Record associated to the Capital Project and has a 
link back to the Opportunity that generated the Capital Project. 



 



General Tab>Opportunity Section 
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 Completing the RPIM Tab 



The RPIM (Real Property Information Model) Tab contains the Office of the Secretary of Defense’s 
required elements for Real Property information. This tab contains seven sections related to Real 
Property assets, though not all are currently used by Air Force Civil Engineers. Many of the fields on this 
tab have specific data requirements and workflows within the system to meet the established 
guidelines. How to input information into the fields is detailed in the following sections of the guide. 
Additionally, the system provides an ‘Attention!’ message at the top of the Capital Project detailing 
errors that may have occurred.   



3.2.2.1 Completing the Project Section 



 On the Capital Project, navigate to the ‘RPIM’ Tab. 



 



Capital Project>RPIM tab 



 On the ‘RPIM’ tab ‘Project’ section: 



 The ‘Project Number’ auto-populates with the Capital Project ID number 
 In the ‘Project Type Code’ field, select the query icon to select the appropriate value from 



the drop-down menu. Populated in section 3.1.1 of this guide. 



Note:  Check the RPUID Cost Breakdown section on the General tab to determine the 
Predominant ‘Project Type Code’ to be used on the RPIM tab 



 The ‘Project Description Text’ field auto-populates the project title in this field 
 In the ‘Project Total Cost Amount’ field, the final total cost for the project is calculated by 



the system. 



NOTE:  This field populates a value once the ‘Project Detail Fund Code Cost Amount’ in the 
‘Project Detail’ section has a value 



RPIM Tab>roject Number, Project Type Code, Project Description, and Project Total Cost Amount 



 Continue the ‘RPIM’ tab, ‘Project’ section: 



 In the ‘Project Completion Date’ field, select the day the project was completed by selecting 
the ‘Calendar’ icon or enter the date manually 



4 
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NOTE:  This field cannot past the current date plus two days. This field is required if there is a 
‘Project Total Cost Amount’ value greater than $0 U.S. Dollars. 



 In the ‘Fund Authorization Amount’ field, insert the amount authorized for project use 



NOTE: Field is required when ‘Project Completion Date’ has a value. Cannot be less than zero.  



 In the ‘Fund Authorization Type Code’ field, select the query icon to select the value from 
the list or enter the code in the field 



NOTE: A ‘Fund Authorization Type Code’ is required if ‘Fund Authorization Amount’ has a value.  



 The ‘CIP accumulated Costs to Date’ field is auto-calculated by the system 
 In the ‘CIP Financial Reporting Organization Code’ field, select the query icon to select the 



value from the list or enter the value in the field 



NOTE:  This field is required when ‘Project Type Code’ equals “CONT” or “CIMP”. 



 



RPIM TAB>Project Completion Date, Fund Authorization Amount, Fund Authorization Type Code, CIP 
Accumulate Costs To Date, and CIP Financial Reporting Organization Code 



 In the ‘Approval Authority’ field, select the ‘Query’ icon, then select the value from the drop-
down menu or enter the value into the field 



NOTE: This field is required when ‘Fund Authorization Amount’, ‘Project Approval Date’, and 
‘Work Order Authorization Date’ have values.  



 



RPIM Tab>Approval Authority 
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3.2.2.2 Project Detail Section 



This section is required when ‘Project Type Code’ equals: “CONT” or “DEMO”. For “CIMP” projects, see 
Completing the Capital Improvement Section 3.2.2.3 of this guide. 



 To add Project Details, select ‘Add’ 



 



Project Detail Section> Add 



 In the ‘Project Detail Section’, ‘General’ tab: 



 Select the ‘Query’ icon in the ‘Project Detail Fund Code’ field to choose from the drop-down 
menu or enter the value manually  



NOTE: This code is used to identify the actual fund type(s) the Project Detail Organization uses 
to fund the work authorized for the real property project (Ex. Main Account of 3400/O&M). This 
is a required field and must have a value when ‘Project Detail Organization Code’ has a value.  



 The ‘Dept Regular Code’ and ‘Sub Account Code’ fields are auto-populated from the ‘Project 
Detail Fund Code’ data 



 In the ‘Project Detail Fund Code Cost Amount’ field, enter the amount of funds expensed in 
the execution of the project 



NOTE:  This is a required field and must have a value when ‘Project Detail Fund Code’ has a 
value. The amount cannot be less than zero. A value of zero is acceptable until final value is 
known. 



 In the ‘Project Detail Organization Code’ field, select the ‘Query’ icon to choose a value from 
the drop-down menu or enter the value manually 



NOTE: The ‘Project Detail Organization Code’ is used to identify the organization funding 
(‘Project Detail Fund Code’) and record the costs (‘Project Detail Fund Code Cost Amount’) of 
the real property project. This is a required field. If multiple Organizations, add additional 
‘Project Detail’ line items.  



 



Project Detail Record> Project Detail Fund Code, Dept Regular Code, Sub Account Code, Project Detail Fund Code 
Cost Amount, and Project Detail Organization Code 
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3.2.2.3 Completing the Capital Improvement Section 



The Project Manager is required to fill out this section when the ‘Project Type Code’ “CIMP” (Capital 
Improvement) is selected.  



To complete this section, perform the following steps: 



 Select the ‘Add’ link; the ‘RPIM Capital Improvement’ form opens. 



 



RPIM Tab>Capital Improvement Section 



 On the ‘RPIM Capital Improvement’ form: 



 The ‘Capital Improvement Record Identifier’ auto populates 
 In the ‘Facility Estimated Useful Life Adjustment Quantity’, enter the value 
 The ‘Capital Improvement Recorded Cost’ auto-populates 
 In the ‘Capital Improvement Placed in Service Date’ field, enter the date the improvement is 



available for use by DoD by selecting the ‘Calendar’ icon or entering in the date 
 In the ‘Capital Improvement Reason Code’ field, select the ‘Query’ icon to choose from the 



drop-down menu or enter the value manually  



NOTE: This code is used to identify the primary reason the capital improvement was performed 



 



RPIM Tab>Capital Improvement 
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 In the ‘Location Lookup’ field, select the ‘Query’ icon to open a new window to choose the 
location (or enter the location number, if known).  



 



RPIM Tab>Capital Improvement>Location Lookup 



 In the ‘Location’ selection window: 



 Select the radio button for the appropriate location 
 Select ‘OK’; the window closes 
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RPIM Tab>Capital Improvement>Location Lookup List 



  ‘Facility Number’ and ‘Real Property Unique Identifier’ auto-populate when a location is chosen 
from Step 4. 



 



RPIM Tab>Capital Improvement>Facility Number and Real Property Unique Identifier 



 In the ‘Capital Improvement Funding Detail’ window, select the ‘Add’ link. 



 



RPIM Tab>Capital Improvement Funding Detail Section 



 In the ‘Project Detail Fund Code’ field, select the ‘Query’ icon and choose the value from the 
menu or enter the value into the field. 



NOTE:  This is a required field and must have a value when the ‘Project Detail Organization 
Code’ field also has a value. 



 



Capital Improvement Funding Detail>Project Detail Section>Project Detail Fund Code 
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 On the ‘Project Detail Fund Code’ window: 



 Select the radio button for the appropriate code 
 Select ‘OK’ 



 



Capital Improvement Funding Detail>Project Detail Fund Code List 



 Continue in the ‘RPIM Project Detail’ window: 



 ‘Dept Regular Code’ and ‘Sub Account Code’ auto-populate from the ‘Project Detail Fund 
Code’ selected in Step 8 



 In the ‘Project Detail Fund Code Cost Amount’ field, enter the amount of funds expensed in 
the execution of the project 



NOTE:  This is a required field and must have a value when ‘Project Detail Fund Code’ has a 
value. The amount cannot be less than zero.  



 In the ‘Project Detail Organization Code’ field, select the appropriate value from the drop-
down menu using the query icon or by entering in the value. The ‘Project Detail 
Organization Code’ is used to identify the organization funding (‘Project Detail Fund Code’) 
and record the costs (‘Project Detail Fund Code Cost Amount’) of the real property project. 



NOTE:  This is a required field. If multiple Facilities and/or Organizations, add additional ‘Project 
Detail’ line items by repeating the steps in this section. 



Capital Improvement Funding Detail>Project Detail Section 
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 Select ‘Create’ to add the Capital Improvement Funding Detail; the window returns to the 
Capital Improvement record. 



Capital Improvement Funding Detail>Create 



 Select ‘Create’ to add the Capital Improvement information.  



 



Capital Improvement>Create











 



P a g e 61 
Section 3.2.3 Review the Cost Details Tab 



 Review the Cost Details Tab 



The ‘Cost Details’ tab is used to view activity in Construction in Progress (CIP) and Work in Progress 
(WIP) accounts. No user input is needed. Monthly reporting of CIP/WIP expenses occur throughout the 
life of the project until the project is completed, financially closed, capitalized, and accepted into the 
Real Property Inventory. This is a read-only tab that is updated from DEAMS and the Capital Project. 



 



Capital Project>Cost Details Tab 



RETURN TO TABLE OF CONTENTS
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 Completing the Schedule Tab 



This tab has a few NexGen IT required fields to be reviewed for ANG Capital Project functionality.  



The ‘Schedule’ tab of a Capital Project can be used to update and manage design/construction tasks 
(Legacy milestones) for a Capital Project. For more information, review the NexGen IT Project 
Management Reference Guide for Active Duty bases. 



3.2.4.1 Completing the Summary Section  



 On the ‘Schedule’ tab ‘Summary’ section, update the following fields: 



The ‘Plan Start’ date auto-populates from the ‘Project Date’ field on the ‘General’ tab, ‘General’ 
section. Update the ‘Plan Start’ date as needed.  



 The ‘Time Zone’ field is a NexGen IT system required field and auto-populates from the 
Installation information for the project. Validate the correct Time Zone is selected or update as 
needed. 



 



Schedule Tab>Summary Section>Plan Start, Time Zone 



 In the ‘Summary’ section: 



Select the ‘Calculate Project From’ drop-down arrow to choose from the drop-down menu. This is a 
NexGen IT system required field. 



NOTE:  If the user selects “Start”, the ‘Construction Actual Percentage’ and ‘Design Actual 
Percentage’ calculate from the start of the project. If the user selects “End”, the Percentages 
calculate to the end of the project. This field defaults to the “Start” option;update as needed. 



 



Schedule Tab>Summary Section>Calculate Project From 



RETURN TO TABLE OF CONTENTS 
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 Completing the Contacts Tab 



Contact roles migrates to the Capital Project upon activation of an Opportunity. Update names following 
steps in section 2.3.2. of this Reference Guide if required.  



RETURN TO TABLE OF CONTENTS
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 Completing the Notes & Documents Tab 



The process for uploading documents to the ‘Notes & Documents’ tab of the Capital Project is the same 
as the process for uploading documents to the ‘Notes & Documents’ tab of the Opportunity. The 
following steps are showing the process on an Opportunity and are identical to the process for the 
Capital Project. 



The ‘Notes & Documents’ tab provides users the ability to store Comments and/or Documents. The 
‘Comments’ section gives users a tool for storing simple text comments. These comments are stored 
with the name of the person making the comment and the date the comment was uploaded. The 
‘Related Documents’ section can store electronic documents in a central storage area for easy retrieval 
by all who have access to NexGen IT.   



To upload comments and documents to the Capital Project, perform the following steps: 



 To post a Comment on an Opportunity or Capital Project: 



 Select the ‘Notes & Documents’ tab 
 In the ‘Comments’ section, select ‘Add’; the Comments record opens 



 



Opportunity Form>Notes & Documents Tab 



 In the ‘Details’ section of the Comment record: 



 Enter a comment in the ‘Comment’ field 
 Select ‘Create’; the screen returns to the ‘Notes & Documents’ tab 



 



Comment Form>Comment 
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 To upload electronic documents to the ‘Notes & Documents’ tab, ‘Related Documents’ section, 
select the ‘Upload’ link; the ‘Object Attachment Upload’ window opens  



 



Notes & Documents Tab>Related Documents Section 



 On the ‘Object Attachment Upload’ window, choose from two options to upload files: ‘Drag and 
Drop’ or use the ‘Single-Upload’ link. For Drag and Drop Method, use the following instructions. For 
‘Single Upload’ link, go to Step 5: 



Drag and Drop method:  Locate the file from your desktop or folder you want to drag and drop: 



 Select the file, then click and hold the left mouse button on the file, and release in the ‘Drop 
Files Here’ window; the upload list populates 



 Select ‘Submit’ to upload the documents to NexGen IT 



 



Object Attachment Upload> Drag and Drop Method (from Desktop) 
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 If selecting the ‘Single Upload’ link, the ‘Object Attachment Upload’ window opens: 



 Select ‘Select File for Upload’; a ‘Choose File to Upload’ window opens  
 Locate and select the file to upload 
 Select ‘Open’ 



 



Open Window 



 The ‘Object Attachment Upload’ window updates 



 The file selected for upload appears in the ‘Document Name’ field 
 Select ‘Submit’ to upload the files to NexGen IT 



 



Object Attachment Upload Window>Upload Link 
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 To upload multiple files, select ‘Select Multiple Files for Upload’ 



 



Object Attachment Upload Window 



 In the ‘Choose File to Upload’ window, navigate to the files for upload: 



 Hold down the CTRL key to highlight multiple files, selecting each file for upload  
 Select ‘Open’  



 



Choose File to Upload Window>Multiple File Upload 
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 In the ‘Object Attachment Upload’ window: 



 A list of all the documents queued for upload displays 
 Select ‘Submit’  



 



Object Attachment Upload>Multiple File Upload 



 Validate all uploaded files show in the ‘Related Documents’ section, then select ‘Save’ to update 
NexGen IT. 



 



Opportunity Form>Notes & Documents Tab 



Currently there are no limitations on file size or number of files that can be uploaded. It is 
recommended to use this capability to store record documents with the Capital Project vs. working 
documents which require more frequent upload/download cycles.   



RETURN TO TABLE OF CONTENTS
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3.3 CAPITAL PROJECT CLOSEOUT 



The Capital Project closeout is primarily an administrative process to ensure completion of required 
fields for functionality at ANG installations.  



This section of the Projects Reference Guide includes instructions for completing the required sections 
and tabs of the Capital Project that apply to the Project Execution and Closeout Process. 



The sections also identify the responsible NexGen IT roles, any pre-requisite actions to perform, and 
what is expected to happen next in the process. 



RETURN TO TABLE OF CONTENTS
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 Completing the DD Form 1354 Tab 



The 1354 Tab of the Capital project enables the acceptance of new construction or capital 
improvements into the real property inventory. 



For training and additional resources on the DD Form 1354 process, please access the NexGen IT Portal 
through the below links: 



 



Air Force NexGen IT Real Property Asset Accountability Series:  



• Part I: Capitalization Explanation and Examples - video 



• Part II: DD Form 1354 Overview - video 



• Part III:  DD Form 1354 Demonstration - video 



 



DD Form 1354 Training: 



• DD Form 1354 Process Map - HTML  



• Create a DD Form 1354 for Capital Projects - PDF 



• Request Clarification on a DD Form 1354 - PDF 



• Delegate Approvals or Notifications - PDF 



 



NexGen IT Portal Link 



https://cs2.eis.af.mil/sites/10041/it_initiatives/nexgen_it/Pages/Homepage.aspx 



Search for “1354” in top-center search box 



 





https://cs2.eis.af.mil/sites/10041/it_initiatives/nexgen_it/Videos/AF_RP_Capitalization_Explanation_and_Examples/AFRPCapitalizationExplanationandExamples.htm


https://cs2.eis.af.mil/sites/10041/it_initiatives/nexgen_it/Videos/DDForm1354_Construction/DDForm1354-Construction.htm


https://cs2.eis.af.mil/sites/10041/it_initiatives/nexgen_it/Videos/SubmitDDForm1354NexGenIT/SubmitDDForm1354NexGenIT.htm


https://cs2.eis.af.mil/sites/10041/it_initiatives/nexgen_it/Related%20Resources%20Library/DDForm1354_ProcessMap.html


https://cs2.eis.af.mil/sites/10041/it_initiatives/nexgen_it/Related%20Resources%20Library/Submit%20a%20DD%20Form%201354.pdf


https://cs2.eis.af.mil/sites/10041/it_initiatives/nexgen_it/Related%20Resources%20Library/Request%20Clarification%20Button.pdf


https://cs2.eis.af.mil/sites/10041/it_initiatives/nexgen_it/Related%20Resources%20Library/Delegate%20Approvals%20and%20Notifications.pdf


https://cs2.eis.af.mil/sites/10041/it_initiatives/nexgen_it/Pages/Homepage.aspx
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 Completing the Capital Project 



Before a Project is completed, the following steps must be performed: 



NOTE:  The Project must be in a “Revision in Progress” status to make edits. 



 On the Capital Project ‘General’ tab, ‘Details’ section: Enter the ‘BOD’ date (if applicable). 



 



Capital Project>General Tab>Details Section>BOD 



 On the Capital Project ‘RPIM’ tab, ‘Project’ section, enter the ‘Project Completion Date’. 



NOTE:  This is required for accurate General Ledger reporting 



 



Capital Project>RPIM Tab>Project Section>Project Completion Date 



 Change the project status from “Active” to “Complete” by selecting ‘Complete’. 



NOTE:  The Capital Project must first be activated and in an Active status before it can be 
completed.  



 



Complete 



RETURN TO TABLE OF CONTENTS
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  Capital Project Closeout 



Once the project is in “Complete” status and is financially complete, the ‘Project Closeout’ button is 
selected to change the status to “Closed”. 



NOTE:  After a project is in ‘Closed’ status, it becomes permanently read-only, and no further 
work can be done on the Capital Project. A “Closed” status is permanent and cannot be 
changed. Do not select the ‘Project Closeout’ button until all work is complete, and the project 
has been financially closed (coordinate with Resource Manager). 



 To change the project status to ‘Closed’, perform the following steps: 



 Open the Capital Project 
 Select ‘Project Closeout’ 



NOTE:  The Capital Project must first be completed before it can be closed.  



 



Project Closeout 



RETURN TO TABLE OF CONTENTS
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 Retire the Capital Project 



Retiring the project removes it from the installation’s list of Capital Projects in NexGen IT. “Complete” 
status of a Capital Project does not remove it from the installation’s list of projects. Only ‘Retire’ a 
Capital Project when it is ready to be placed in archive.  



NOTE:  A Capital Project can only be placed into a ‘Retired’ status after it has been “Activated” 
the first time, and at any point in the lifecycle process thereafter.  



 To change the Capital Project status to “Retired”, perform the following step: 



 Select the ‘More’ drop-down arrow 
 Select the ‘Retire’ option from the drop-down menu on the Capital Project 



 



Capital Project>More>Retire 



Return to Table of Contents 



 











 



P a g e 7 4  



APPENDIX A 
 



 











 Air Force Civil Engineer Center, Functional Management Office  
NexGen IT Reference Guide for ANG Project Management 



 



P a g e 75 
Appendix A: CE Acronyms and Glossary 



CE ACRONYMS AND GLOSSARY 



TERM DEFINITION 



AAFES Army and Air Force Exchange Service 



Accountability The obligation that a law or regulation imposes to keep accurate records of 
property, documents and funds 



ACE Army Corps of Engineers (also known as 'Corps,’ CoE, USACE) 



ACES Automated Civil Engineer System.  



ACES-RP Automated Civil Engineer System-Real Property Module 



ACES-FM Automated Civil Engineer System- Financial Management Module 



ACES-PM Automated Civil Engineer System- Project Management Module 



Acquisition The original use or control of Real Property (RP) or an interest in RP by purchase, 
condemnation, donation, exchange, leasing, or recapture. 



Acquisition Cost The amount, net of both trade and cash discounts, paid for the property, plus any 
ancillary costs. 



Activation Establishing an Air Force function at a current Air Force installation or facility or 
the activation of a new installation. 



AEP Accrued Expenditures Paid 



AEU Accrued Expenditures Unpaid 



AF Air Force (also known as USAF) 



AF Form 1192  USAF Installation Characteristics Report 



AF Form 1354  Building Information Checklist 



AFCAMP Air Force Comprehensive Asset Management Plan 



AFCEC Air Force Civil Engineer Center 



AFDD Air Force Doctrine Document 



AFERS Air Force Energy Reporting System 



AFH Air Force Handbook 



AFHQ Air Force Headquarters (also known as HAF or HQ USAF) 



AFI Air Force Instruction 



AFR Air Force Reserve 



AMP Activity Management Plan or Asset Management Plan 



AMRS Advanced Meter Reading System 



APSR Accountable Property System of Record 
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TERM DEFINITION 



Asset Anything having monetary value. A Department of Defense (DoD) asset is any item 
of economic value owned by a DoD Component or held in a fiduciary capacity 
under the control of a DoD Component. The item may be physical in nature 
(tangible) or a DoD Component may have a right to control the item (intangible). 
The value of a DoD asset expressed in terms of its acquisition cost and control of 
the asset by a particular DoD Component must be the result of a past transaction 
or event. 



ATA  Authority to Authorize or Authority to Advertise 



BCE Base Civil Engineer 



BOD Building/Beneficial Occupancy Date. This date represents the date the facility or 
improvement to a facility is available for use. Formerly known as the “Beneficial 
Occupancy Date.” Also known as Date Placed in Service. 



BUILDER The authoritative data source for Installed Building Equipment 



Building A roofed, floored, and walled facility that is completely enclosed and is used to 
house human activities. 



Capital 
Improvement 



Acquisition or improvement to RP that increases the RP asset’s unit of measure, 
efficiency, or useful life. 



CATCODE Category Code. A six-digit numerical code that represents a specific type of facility 
from the Office of the Secretary of Defense (OSD) Factor Analysis Codes. 



CATEX Categorical Exclusion 



CE Civil Engineer 



CEMAS Civil Engineering Material Acquisition System 



CEN Civil Engineering Flight 



CET Civil Engineer Transformation 



CEQ Council on Environmental Quality 



CFO Chief Financial Officer 



CFR Code of Federal Regulations 



CG Capability Group 



CIP Construction in Progress 



CIP Account Construction-in-Progress Account 



CLIN Contract Line Item Number 



CO Contracting Officer 



CoE Corps of Engineers (also known as ACE, 'Corps,' USACE) 
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TERM DEFINITION 



Consideration Compensation or an equivalent (such as money, material or services) that is given 
for something acquired or promised. 



Construction Erect, install, assemble, alter, expand, or replace a facility. 



Contract An enforceable agreement, including rental and lease agreements and purchase 
orders between an agency and a business concern for the acquisition of property 
or services. 



COR Contracting Officer’s Representative 



Cost Accounting Cost accounting is a broad, crosscutting function focused on identifying and 
accounting for the costs incurred during numerous Civil Engineer activities.  



COTS Commercial-Off-The-Shelf 



Cst Report name prefix that means it is an AF customized report 



CSU Customer Service Unit 



CWE Current Working Estimate 



DB Design Build 



DBB Design-Bid-Build 



DD Defense Department (also known as DoD); usually referencing Defense 
Department forms. 



DD Form 1391 The DD Form is required for MILCON opportunities and for non-MILCON 
opportunities which require review at the MAJCOM level or above 



DEAMS Defense Enterprise Accounting and Management System 



DI Design Instruction 



Disposal Any authorized method of permanently relinquishing Air Force control, 
accountability or responsibility for RP. 



DLA Defense Logistics Agency 



DoD Department of Defense (also known as DD) 



DSW Direct Scheduled Work 



EA Environmental Assessment 



Easement The legal right to use land of another for a specified purpose. 



ECZ Expanded Clear Zone 



EEIC Element of Expense Investment Code 



EIAP  Environmental Impact Analysis Process 



EIS Enterprise Information System 



EIS Environmental Impact Statement. 
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TERM DEFINITION 



EO Executive Order 



EOY End of Year 



EQ Environmental Quality 



Facility A building, structure, or linear structure out to an imaginary line surrounding a 
facility at a distance of five feet from the foundation that, barring specific direction 
to the contrary such as a utility privatization agreement, denotes what is included 
in the basic record for the facility (e.g., landscaping, sidewalks, utility connections). 
This imaginary line is what is commonly referred to as the “five-foot line.” 



Facility Number A unique number assigned to a facility at the time of its conception. 



FB Facilities Board 



FC Fund Code. The Fund Code (FC) is a two-digit code that describes an appropriation. 



FDUI Funding Document Unique Identifier 



FIAR Financial Improvement and Audit Readiness 



FISCAM Federal Information System Controls Audit Manual 



FM Financial Manager 



FMO Financial Management Office 



FONSI Findings of no Significant Impact 



Functional(s) An individual(s) or element within Air Force Civil Engineering responsible for an 
area of expertise. For example, Asset Management, Resources Flight, Operations 
Flight, Programs Flight, Fire Department, Readiness Flight, Installation RPO, etc. 



FY Fiscal Year 



FYDP Future Years Defense Program 



GFE Government Furnished Equipment 



GOCESS Government-Operated Civil Engineer Supply Store 



HAF Headquarters, Department of the Air Force (also known as AFHQ, HQ USAF) 



HQ Headquarters 



IAW In Accordance With 



IDP Installation Development Plan 



Installation An installation is a general term that describes a collection of sites – one of the 
sites is referred to as the primary site – and the Installation Record shares the 
attributes of the primary site. The installation is not a physical location, but an 
administrative record. An installation is a grouping of sites under a singular 
command’s support. The site assets are the physical locations. 
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TERM DEFINITION 



Installation Code A code that identifies an installation and distinguishes one installation from 
another. Air Force uses a four-digit alpha GEOLOC code for each site. 



Installation RPO Installation Real Property Office.  



Interest Right, claim, title, or legal share in RP. 



Interest Code A code that identifies the Air Force’s interest (e.g., AFDD IN-001). 



Inventory A physical inspection of facilities. 



IOC Initial Operation Capability 



IPL Integrated Priority List 



IT Information Technology 



IWIMS Interim Work Information Management System 



JA Judge Advocate. An office that provides legal assistance and counsel to the 
Installation RPO. 



Java A general-purpose computer programming language that is concurrent, class-
based, object-oriented, and specifically designed to have as few implementation 
dependencies as possible. 



Lease The contractual agreement between the owner (lessor) and user (lessee) for the 
exclusive use of real or personal property. 



LOE Level of Effort 



LOV List of Values 



M/C Minor Construction 



Maintenance Work required preserving and maintaining RP in such condition that it may be 
effectively used for its designated functional purpose. 



MAJCOM Major Command 



MC Minor Construction 



MFH Military Family Housing 



MILCON Military Construction. Any construction, alteration, development, conversion, or 
extension of any kind carried out with respect to a military installation. 



NEPA National Environmental Policy Act 



NTP Notice to Proceed 



OBAN Operating Budget Accounting Number 



Opportunity A set of defined requirements to conduct construction, repair, maintenance, or 
demolition of a new or existing complete and useable facility 



Organization Code Identifies the user or users of a facility. 
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TERM DEFINITION 



PA  Programmed Amount 



PAD Program Action Directive 



Partner Individual or organization that may assist the Installation RPO in performing a 
particular task.  



PDRI Project Definition Rating Index 



PEC Program Element Code 



Permit An instrument providing a property interest to another government entity. 



PM Preventive Maintenance 



PM Project Manager 



PM Project Management 



PMO Program Management Office 



PMP Project Management Plan 



PO Purchase Order 



POI Post Occupancy Inspection 



POM Program Objective Memorandum 



PoP Period of Performance 



PP&E Property, Plant, and Equipment.  



PR Purchase Request 



Primary 
Installation 



A self-supporting installation, with or without an aircraft operating area that has 
facilities for administrative and operational activities to carry out a given mission.  



Purchase By fee simple acquisition the Air Force has full, absolute dominion over the 
property to sell or dispose of. 



R&M Restoration and Modernization 



Repair A project to restore a RP facility, system, or component to such a condition that it 
may effectively be used for its designated functional purpose. 



RFP Request for Proposal 



RFQ Request for Quote 



RP Real Property. Land and improvements to land (e.g., facilities). It includes 
equipment affixed and built into the facility as an integral part of the facility (such 
as heating systems), but not movable equipment (e.g., plant equipment, industrial 
equipment, buoys). In many instances, this term is synonymous with RE. 



RPA Real Property Asset 



RPAO/RPO Real Property Accountable Officer/Real Property Officer 
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TERM DEFINITION 



RPIM Real Property Information Model 



RPO Real Property Officer 



RPSUID Real Property Site Unique Identifier 



RPUID Real Property Unique Identifier 



Semi-permanent 
Construction 



A facility suitable and appropriate to serve a specific purpose for a limited period 
of time (5 to 25 years) with a moderate to high degree of maintenance. 



SIOH Supervision, Inspection, and Overhead 



Site A Site Record is a grouping of assets physically located together. The Land, 
Structure, Linear Structure, or Building Record on which the site is established is 
associated to the Site Record.  



SLA Service Level Agreement 



SME Subject Matter Expert 



SOP Standard Operating Procedure 



SOW Statement of Work 



SR Service Request 



SRM Sustainment, Restoration, and Modernization 



Structure A facility other than a building or utility. 



SVS Services 



Tenant An organization or other entity occupying Air Force RP (also known as TEN) 



TMA TRICARE Management Activity 



Transfer RE action that conveys the custody and control of RP and its related RPIE from one 
Air Force activity to another or to another military department or federal agency. 



tri Report name prefix that means it is an IBM created report in . 



UOM Unit of Measure 



UOO Undelivered Orders Outstanding 



USAF United States Air Force (also known as AF) 



Useful Life See “Estimated Useful Life.” 



Utility A distribution system, commodity source, or commodity collection point that 
provides a common service or commodity to more than one building or structure. 



WBT Web-Based Training 



WIP Work In Progress 



W/O Work Order 
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TERM DEFINITION 



Work 
Classification 



Opportunities must be classified as a certain type of work which drives what 
funding sources and program types are used. The three main work classifications 
are: repair, maintenance, and construction 



WRRB Work Request Review Board (Also known as WORB) 
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‘COPY’ BUTTON 



Not all data fields of an Opportunity are copied when the ‘Copy’ button is used. The following are the 
only fields copied when the ‘Copy’ button is selected.   



NOTE:  The ‘FY’, ‘Locations’ section, nor the ‘RPUID Cost Breakdown’ section are copied.  
(Reference 2.3.1.4. and 2.3.1.7.)



General Tab> 
General Section:  
Name 
Description 
IPL Category 
Execution Method 
Program (PEC) 
Cost Element Code (EEIC) 
Base Justification 
Project Eligibility Code 
Trans Code 
Program Type 
Category Code 
Opportunity Type 
Project Number (Legacy) 
 



Financial Section: 
Funding Status 
Funding Source 
Funding Subsource 
PB-28 Category 
 
Details Section:  
Work Classification 
Unit Requesting project 
Command 
Requiring Command 
Statutory Approval 
Wing Number 
Installation Name 
MAJCOM Name 



Infrastructure system 
impacted by project 
 
CATEX Section: 
CATEX Required 
Categorical Exclusion 
 
Cost Section: 
Quantity 
Estimated Cost Per Unit 
Total Other Costs 
Unfunded Amount 
 
 
 



Environmental Tab>General 
Section: 
Pollutant category 
Compliance Date 
IST 
RST 
Owner 
Statutory Authority 
 
Base Scoring Section: 
Base EQ Scoring Category 
Base concern 
Base Environmental Risk 
Base Investment 
Base Mission 
Base Regulatory 
Base Score Justification 



RST/IST Level 3 Validation: 
Validation Amount 
EQ Scoring Category 
Concern 
Environmental Risk 
Investment 
Mission 
Regulatory 
Score Justification 
 
AFCEC Env Level 2 Section: 
Validation Amount 
EQ Scoring Category 
Concern 
Environmental Risk 
Investment 
Mission 



Regulatory 
Score Justification 
 
HAF/IMSC Level 1 Section: 
Validation Amount 
EQ Scoring Category 
Scoring Subfactors 
Score Justification 
 
Financial Section: 
Acquisition Strategy 
Execution Agent 
District 
OBAN 
Total Required Amount 
Funds Req (All Months) 
Type of Contract 
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Priority Tab> 
 
Technical Details Section:  
Scoring Factor1  
Interest Item 1 
Scoring Factor 2  
Interest Item 2 
Scoring Factor 3  
Interest Item 3 
Scoring Factor 4 
Interest Item 4 
Base Priority Section: 
Base Priority 
 



Energy Tab>  
Energy Opportunity Details Section: 
Energy Opportunity Classification 
Technology Type 
Opportunity Source 
 
Contacts Tab>  
Contacts Section: 
All contacts listed 
 



 
RETURN TO TABLE OF CONTENTS 













Always On Mission 50



Real Property Key Supporting Documents (KSD’s)



• Operational & Maintenance (O&M) projects.











Always On Mission 51



Real Property Key Supporting Documents (KSD’s)



• Unspecified Minor Military Construction (UMMC) projects.











Always On Mission 52



Real Property Key Supporting Documents (KSD’s)



• Military Construction (MILCON) projects.











Always On Mission 53



Real Property Key Supporting Documents (KSD’s)



• Military Construction (MILCON) projects.











Always On Mission 54



Real Property Key Supporting Documents (KSD’s)



• In-house projects.











This ANGETL Index is maintained by: Jacqueline Nino, NGB/A4O, DSN 612‐8117, jacqueline.nino@us.af.mil


ETL Title Date Status Office OPR Supersedes


91-08 Use of Unit Pricing Procedures for Pavements Contracts 18-Jun-91 Active A7O Freese
92-3 Systems Furniture Management 18-Jun-92 Active A7O Gordey 91-4
10-03 Air National Guard Design Objectives and Procedures 16-Apr-10 Active A7O Freese 02-01
10-04 Military Construction Cooperative Agreements (MCCA) 3-Jun-10 Active A7O Babalola


11-12 Compliance with Handicapped Accessibility Standards 16-Dec-11 Active A7O Doody 98-02


12-05 Design and Construction Handbook 6-Jul-12 Active A7O Nino/ 
Morrison


90-06, 90-08, 
93-07, 93-08, 
93-12


12-07 Preparation of Project Documentation Package 6-Jul-12 Active A7O Nino/ 
Morrison


90-06, 90-08, 
93-07, 93-08, 
93-12


14-01
Authorized Element of Expense Investment Codes and Financial Plan 
Preparation for Facilities Operations and Maintenance Activities, 
Environmental, Fire Protection Activities and ANG Services Programs


19-Dec-14 Active A7R 10-01


14-11 Policies and Procedures for Tracking and Reporting Local SRM Funds 18-Feb-14 Active A7A Mattoch New
14-12 Funds to Support Organizational Equipment 19-Dec-14 Active A7R Coles 08-2
14-13 Janitorial Services (EEIC 570F8) under Appendix 21, FOMA 19-Dec-14 Active A7R Coles 10-02
14-14 Policies and Procedures for Calculating Work Order Shop Rates 19-Dec-14 Active A7R Coles 05-1
14-15 Managing, Operating and Maintaining Aircraft Arresting Systems. 19-Dec-14 Active A7OC Love 08-1
15-01 Air National Guard Design Policy 1-May-15 Active A7O Rowand 01-1-1


15-01-01 Sustainable Design, Development and Resource Conservation 1-May-15 Active A7O Rowand New


15-01-02 SKIF & ATFP Guidance 1-May-15 Active A7O Shorey            
Olson New


15-01-03 Fire Protection Design Guidance 1-May-15 Active A7OC Becker 01-1-1, 11-11


15-01-04 Mechanical Engineering 1-May-15 Active A7OC Anderson   
Rowand 01-1-1


15-01-05 Electrical & Communication Engineering 1-May-15 Active A7OC Knudsen 01-1-1
15-01-06 Roof Design Guidance 1-May-15 Active A7O Andari 01-1-1, 93-04


15-01-07 Airfield & Vehicle Pavement Design 1-May-15 Active A7O Andari     
Love 01-1-1


15-01-08 ANG Generators 1-May-15 Active A7OC Knudsen New
15-03 Project Closeout Process 18-Mar-15 Active A7O Nino 09-11
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ETL Title Date Status Office OPR Supersedes


16-02 Design and Construction Reports 30-Dec-16 Active A4O Nino 15-02


16-03 Design Meetings & Presentations 1-Dec-16 Active A4O Nino


17-02 Facility Board Implementation 31-May-17 Active A4A Mittler


19-12 Geographic Information System (GIS) Data Format Specifications 18-Nov-19 Active A4AM Sattazahn 18-11


21-11 Programming Guidance 16-Apr-21 Active A4AD Evans 19-11


21-13 Sustainment Management Systems Guidance 12-Jan-21 Active A4AI Jiminez


21-14 Air National Guard Capitalization and Construction in Progress (CIP) 
Process


18-Aug-21 NEW A4AI Hanania 17-06
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